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ABSTRACT

The Systems Analysis Programs for Hands-on Integrated Reliability Evaluations (SAPHIRE) refers to a
set of computer programs that were developed to create and analyze probabilistic risk assessment (PRAs).
This volume is the tutorial manual for the SAPHIRE system. In this document, a series of lessons are
provided that guide the user through basic steps common to most analyses preformed with SAPHIRE.
The tutorial is divided into two major sections covering both basic and advanced features. The section
covering basic topics contains lessons that lead the reader through development of a probabilistic
hypothetical problem involving a vehicle accident, highlighting the program’s most fundamental features.
The advanced features section contains additional lessons that expand on fundamental analysis features of
SAPHIRE and provide insights into more complex analysis techniques. Together, these two elements
provide an overview into the operation and capabilities of the SAPHIRE software.
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FOREWORD

The U.S. Nuclear Regulatory Commission has developed the Systems Analysis Programs for Hands-on
Integrated Reliability Evaluations (SAPHIRE) software used to perform probabilistic risk assessments
(PRAs) on a personal computer. SAPHIRE enables users to supply basic event data, create and solve fault
and event trees, perform uncertainty analyses, and generate reports. In that way, analysts can perform
PRAs for any complex system, facility, or process.

SAPHIRE can be used to model a plant's response to initiating events, quantify core damage frequencies,
and identify important contributors to core damage (Level 1 PRA). The program can also be used to
evaluate containment failure and release models for severe accident conditions, given that core damage
has occurred (Level 2 PRA). In so doing, the analyst could build the PRA model assuming that the reactor
is initially at full power, low power, or shutdown. In addition, SAPHIRE can be used to analyze both
internal and external events, and it includes special features for transforming models built for internal
event analysis to models for external event analysis. It can also be used in a limited manner to quantify
the frequency of release consequences (Level 3 PRA). Because this software is a very detailed technical
tool, users should be familiar with PRA concepts and methods used to perform such analyses.

SAPHIRE has evolved with advances in computer technology. The versions currently in use (6 and 7) run
in the Microsoft Windows® environment. A user-friendly interface, Graphical Evaluation Module
(GEM), streamlines and automates selected SAPHIRE inputs and processes for performing event
assessments.

SAPHIRE has also evolved with users' needs, and Versions 6 and 7 include new features and capabilities
for developing and using larger, more complex models. For example, Version 7 can solve up to 2 million
sequences and includes enhancements for cut set slicing, event tree rule linkage, and reporting options.

This NUREG-series report comprises seven volumes, which address SAPHIRE/GEM Versions 6 and 7.
Volume 1, "Overview/Summary," gives an overview of the functions available in SAPHIRE and presents
general instructions for using the software. Volume 2, "Technical Reference," discusses the theoretical
background behind the SAPHIRE functions. Volume 3, "SAPHIRE Users' Manual," provides installation
instructions and a step-by-step approach to using the program's features. Volume 4, "SAPHIRE Tutorial
Manual," provides an example of the overall process of constructing a PRA database. Volume 5,
"GEM/GEMDATA Reference Manual," discusses the use of GEM. Volume 6, "SAPHIRE Quality
Assurance (QA) Manual," discusses QA methods and tests. Lastly, Volume 7, "SAPHIRE Data Loading
Manual," assists the user in entering PRA data into SAPHIRE using the built-in MAR-D ASCII-text file
data transfer process.

Christiana H. Lui, Director
Division of Risk Analysis
Office of Nuclear Regulatory Research
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EXECUTIVE SUMMARY

In this tutorial, lessons are provided that guides the user through the basic procedures necessary to
perform analyses with the Systems Analysis Programs for Hands-on Integrated Reliability Evaluations
(SAPHIRE) software package. Specific instructions for individual commands and options available in
SAPHIRE are provided in the SAPHIRE Code Reference Manual (Volume 3) that accompanies this
report.

The Basic Lessons section contains an example of an accident scenario and allows the user to become
familiar with the basic menu structure and features of SAPHIRE. The Basic Lessons section covers the
following topics:

. Adding and Selecting a Project

. Building Event Trees

. Building Fault Trees

. Entering Basic Event Information

. Graphical Output

. Generating, Displaying, and Reporting Fault Tree Cut Sets
. Fault Tree Uncertainty Analysis

. Generating Event Tree Cut Sets

The Advanced Features section goes into detail of the SAPHIRE advanced features using the example
database. Each lesson stands alone, but a lesson will generally build on the basic example. The Advanced
Lessons section covers the following topics:

. Creating Change Sets and Flag Sets
. The “Linking” Rule Editor
. Recovery Rules

For each topical area, systematic instructions are provided to guide the user through that procedure.
Applicable screen shots accompany the textual instructions.

It is assumed that the SAPHIRE program has been successfully loaded onto a personal computer, that the
user is familiar with the operations of Microsoft Windows™, a standard mouse, and that the user has a
basic knowledge of event trees and fault trees. The user will have found reading Section 2.0 of the
SAPHIRE Code Reference Manual (Volume 3) provided an overview of the SAPHIRE software, menu
structure, and database concepts for the general knowledge of the program.
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Systems Analysis Programs for Hands-on Integrated
Reliability Evaluations (SAPHIRE)

Vol. 4 Tutorial
1. INTRODUCTION

In this tutorial, a series of lessons is provided that guides the user through the basic procedures necessary
to perform analyses with the Systems Analysis Programs for Hands-on Integrated Reliability Evaluations
(SAPHIRE) software package. Specific instructions for individual commands and options available in
SAPHIRE are provided in the SAPHIRE Reference Manual that accompanies this report.

This tutorial is separated into two major sections: 1) Basic Lessons and 2) Advanced Features. The Basic
Lessons section contains a simple example of a trucking accident and allows the user to become familiar
with the basic menu structure and features of SAPHIRE. The Advanced Features section goes into detail
of the SAPHIRE advanced features using the example database. The Basic Lessons section contains
Lesson 1 through Lesson 8, while the Advanced Features section covers Lesson 10 through Lesson 12.
Each lesson stands alone, but a lesson will generally build on the basic example.

Basic Lessons

The Basic Lessons (Section 2) section covers the following topics:

Lesson 1. Adding and Selecting a Project
This lesson describes the process of adding and selecting a project called “PRACTICE.” Adding and
selecting a project is the first step in developing the example analysis.

Lesson 2. Building Event Trees

This lesson describes the specific process of creating the event tree called “OBSTRUCT” that will be
used in the example analysis.

Lesson 3. Building Fault Trees

This lesson describes the specific process of creating a basic fault tree. In this lesson, five simple fault
trees will be constructed and saved.

Lesson 4. Entering Basic Event Information

This lesson describes the process of entering basic event information including mean failure rate,
probabilities, and uncertainty data.

Lesson 5. Graphical Output

This lesson describes the steps required to print event tree and fault trees to a printer or a file. The lesson
also briefly describes how to export SAPHIRE graphic in the form of a metafile to be used by other
software packages.



Lesson 6. Generating, Displaying, and Reporting Fault Tree Cut Sets

This lesson describes the process of solving and quantifying fault tree cut sets. The lesson also includes
information pertaining to displaying and printing cut sets. For this lesson, cut sets will be produced for
the three fault trees developed in Lesson 3.

Lesson 7. Fault Tree Uncertainty Analysis

This lesson describes the process of performing an uncertainty analysis for the fault trees created in
Lesson 3.

Lesson 8. Generating Event Tree Cut Sets

This lesson describes the process of linking an event tree and solving sequence cut sets. The lesson also
includes information pertaining to displaying and printing sequence cut sets reports. For this lesson, cut
sets will be produced for the event tree developed in Lesson 2.

Advanced Lessons

The Advanced Lessons section (Section 3) covers the following topics:

Lesson 10. Creating Change Sets and Flag Sets
This lesson describes the difference between a flag sets and a change sets and guides the user on how to
implement them into SAPHIRE.

Lesson 11. The “Linking” Rule Editor
Lesson 11 introduces the user to SAPHIRE “Link Event Tree” rule editor. The rule editor allows you
create rules that affect the event-tree linkage process and sequence generation.

Lesson 12. Recovery Rules
Lesson 12 introduces the user to the “Recovery Rule” editor of SAPHIRE. The recovery rule editor
allows you to create rules that affect existing cut sets in a “post-processing” manner.

The tutorial assumes that the user has performed or has general knowledge of the following:

1. The SAPHIRE program has been successfully loaded onto a personal computer as described in
Appendix A of the SAPHIRE Reference Manual. The user is also familiar with the operations of
Microsoft Windows™ and a standard mouse.

2. The user has a basic knowledge of event trees and fault trees.

3. The user has read Section 2.0 of the SAPHIRE Reference Manual that provides an overview of the
SAPHIRE software, menu structure, and database concepts.



2. BASIC LESSONS

The purpose of the Basic Lessons section is to familiarize the user with the fundamental features and
operations of SAPHIRE software. In the following eight lessons, a simple example is developed that
models the frequency of a trucking incident that results in the loss of cargo. While creating this model,
the user will construct an event tree and several fault trees; enter basic event data; solve fault tree cut sets;
and link and solve sequence cut sets.

For this tutorial, failure/success logic was used to develop an event tree to calculate the frequency that a
semi-truck hauling hazardous waste encounters an obstruction in the roadway (downed tree, fallen rock,
animal, stalled automobile, etc.) that causes an accident that result in the load being separated from the
truck. The time of interest is over a one-year period. The event tree consists of the initiating event, 1E-
OB and three top events or systems that could prevent the end-state (load separation) from occurring. The
initiating event, IE-OB, is the number of occurrences in a period that initiate the sequence of events. For
this case, it is assumed there are approximately three hazardous shipments a week over 52 weeks. In
addition, for discussion of the example, it is assumed that experience has shown that for about one-half of
the time, the driver reports that they encountered some sort of obstruction in the roadway during the route.
These analysis boundary conditions will be embodied in the example model.

21 Lesson 1 - Adding and Selecting a Project

In Lesson 1, the user will add a new project called PRACTICE. This is the first step in developing the
sample example.

SAPHIRE is a menu-driven application. The Main Screen consists of a title bar, menu bar, and a
graphical tool bar. The main menu is shown below in Figure 1. SAPHIRE allows the user various
alternatives to set up the menu structure. To select any of the menu options, maneuver the mouse pointer
over the desired option in either the menu bar or the graphical tool bar and click the left mouse button.
Both the menu bar and graphical tool bar perform the same function in accessing the menu options.

For the remainder of the tutorial, only the graphical tool bar will be referenced.
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Figure 1 SAPHIRE Main Menu



To change the menu appearance, select Utilities in the Toolbar and then Constants and select the
desired display method, Toolbar buttons, and Toolbar positions by selecting the desired radio buttons.

STEP 1: Add a New Project

The SAPHIRE database structure is divided into “projects”. A project is any logical grouping of fault
trees, event trees, cut sets and basic events with their respected reliability and uncertainty data. Each
project in setup in a separate Windows™ based folder. Therefore, for any new analysis to be
accomplished, the first step is to set up a new SAPHIRE database project.

In this step, the user will add a project called PRACTICE. This project will be used throughout the
tutorial to store and develop the example problem database.

To add a project in SAPHIRE, perform the following steps:

Select New on the Graphical Tool Bar (or File on the Menu Bar, then New Project). SAPHIRE
will ask if the user wants to “create a new project”. Select Yes.

The “New Project-Project Name” box will appear. Type in the new project name, PRACTICE and
click on @ SAPHIRE indicates where the new project will be located. The default setup for
SAPHIRE is to create project sub-folders in the SAPHIRE main directory (i.e. C:\SAF60). However, the
user has the ability to change to the location of the project folder to any location by clicking on the
“Browse...” button. Click on @(I to create the new project folder.

SAPHIRE creates the new project folder and automatically places the user in the new project,
PRACTICE.

STEP 2: Select a Project (Optional)

Since the new project created in SAPHIRE is automatically selected after its been created, this step is not
necessary to perform in order to continue with the example problem. However, if the user wanted to go
back to another previous project (for example, the DEMO project), this step would be necessary.

To select a project in SAPHIRE, the following steps are required:

Select Open on the Graphical Tool Bar (or File on the Menu Bar, then Open Project). In the
browse box, select the desired project folder using the drop down menu button or the “Up Folder” button
as shown in Figure 2.

Select the project name “.SRA” file (i.e. <project name>.SRA ) and click on Open. The project is
now selected and available for analysis.
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2.2 Lesson 2 - Building Event Trees

In Lesson 2, the user will create the “OBSTRUCT” event tree shown below in Figure 3. This event tree is
used to generate the sequence logic for the example problem. The exercises in this lesson will guide the
user through the process of creating an event tree in SAPHIRE.

OBSTRUCTION TRUCK DRIVER AVOIDS LOAD
IN ROADWAY BRAKING OBSTRUCTION CONSTRAINTS
SYSTEM
1E-OB BRAKE-SYS OP-MANEUVER LOAD # END-STATE-NAMES
,— 1 OK

I— 2 RELEASE

3 OK
I: 4 RELEASE
5 OK

OBSTRUCT - OBSTRUCTION IN ROAD 2002/12/12 Page 1

Figure 3 The OBSTRUCT Event Tree

Shown in Figure 3, the initiating event, [E-OB, is depicted by an initial horizontal line, with systems (top
events) connected in a branching system with an “up” branch indicating success and the down branch
indicating failure. The event tree top events are questioned from left to right. A top event can also be
passed indicating that no success/failure questioned was posed and the next system top event is
questioned. The unique combination of system failures and/or successes from the initiating event to the
end-state defines the “sequence” for that particular path. An “end-state” is a group of accident sequences,
which share certain characteristics that the analyst determines. For this example problem, there is only
one end-state called “RELEASE”.



UICK TIP

SAPHIRE has pop menus throughout its menu structure. To evoke a pop-up menu, click on the
right mouse button <right click> and move the highlight to the desired function.

STEP 1: Create an New Event Tree Using the Event Tree Using the Event Tree Graphics Feature
The following information guides the user on creating a new event tree in SAPHIRE. The event tree
OBSTRUCT, shown in Figure 3, will be constructed using the detailed steps below.

To develop a new event tree, first access the event tree graphics feature by selecting the Event Tree
button in the Main Menu (6" tool button from the left). This will bring up a list of event trees in the
database as shown in Figure 4. The current database for this tutorial has no event trees; therefore, the
screen is blank with no event tree names listed.

" SAPHIRE for Windows - [PRACTICE project - D:\saf60\PRACTICE)

@&l | 1 | (@]

f{Event Tree List - [PRACTICE] 2] %]

Fietum
™ Show Sub-Trees Marked # 0

KEE sawomd@ [

8l e |22 D & |l Dl |

Event Tree Mask Mazk Action

I* = [nciuder € Exclide Apply Mask

Ewent data zet to baze caze [ho changes] Proceszing record 4 of 4 tatal records
ghstan||| @ @ 7] 4 @ || @ SconBeck - Inbox - Lows .| B ah.bmp - Paint | [#)5APHIRENUREG.doc - bi. || 49 SAPHIRE for window__  ||<5-€) @A 1014am

Figure 4 Event Tree List



To build the OBSTRUCT event tree, perform the following steps:

Place the mouse cursor anywhere in the “Event Tree List” box and click the right mouse button to
access the pop-up menu. Highlight Add Event Tree and then click the left mouse button.

The “Event Tree” box will be displayed. Type in the word “OBSTRUCT” for the Name of the
event tree and any description desired. Click on the @ button when completed. There now will be the
event tree OBSTRUCT listed in the Event Tree List box.

Event Tree 2|

Mame CBRSTRUCT Intiztor I =IMIT= j

Description | Tutorisl Evert Tree for Trucking Accideri

Ok | cancel |

Highlight the new OBSTRUCT event tree name and click on the right mouse button. Highlight
the “Edit Graphics” option.

SAPHIRE will inform the user that no graphic exist for the selected event tree and ask if the user
would like to create the event tree. Click on .

A series of questions regarding the top events will be displayed. The first question asks for the
initiating event name and description. Type in [E-OB for the Name and any Description desired. Make
certain that the Initiating Event box is checked ([). When finished, click on the button.

Enter Initiating Event or Top Hame 7| x|
Maime Description Adlcl
| E-0B OBSTRUCTION =
I ROADALY Done |

¥ Initiating Event LI

The next box displayed is the “Enter Event Name #1” box. Type in BRAKE-SYS and any
description desired and then click on the @I button.

Enter Event Name 1 1
Mame Description
| BRAKE-SYS TRUCK =
BREAKING o
SYSTEM one

I Initiating Event L|




The “Enter Event Name #2” box will appear. Type in OP-MANEUVER and any description
desired. Click on the @I button when finished. The “Enter Event Name #3 box will appear. Type in
LOAD and any desired description. When all the top events have been entered, click on

After all the top events have been added, SAPHIRE will show the user the top event layout for the new
fault tree. Figure 5 shows the Event Tree Editor screen that is displayed. From this screen, the user can
edit any of the top event and descriptions, add branching, and add end states. Also in Figure 5 is an
example of the graphical layout of the Event Tree Editor tool bar (located at the top).

=
ARG i Event Tree Editor - DBSTRUCT. ETG

File Edit “iew Help

o
&
3

L& 73[R |« | € | € |4 B |© B

=1

ﬂ -
Record added. LI _I Llj
#san|| & @ A 4 @ || Bahomp-Fant | B 5APHIRENUREG. doc - Mi..| [ SAPHIRE tor Window._ [ eBN z02rM

Figure 5 Example of the graphical event tree editor

STEP 2: Add/Edit Branching to the New Event Tree Using the Event Tree Editor

The following information guides the user on adding branching to the new event tree in SAPHIRE.
Typically, in an event tree, the up branch represents success and down branch represents failure. As event
tree logic is developed, a top event can be passed (no success/failure questioned asked) or branched. The
sequence logic resulting in an end-state is developed as the branches are added.
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For the event tree OBSTRUCT, Figure 2-3 show that after the top event BRAKE-SYS is questioned, the
success branch passes over OP-MANEUVER and questions the top event LOAD. The failure branch of
BRAKE-SYS questions OP-MANEUVER and on both the success and failure of OP-MANEUER,
questions the top event, LOAD. To add these branches to the new event tree, OBSTRUCT, perform the
following steps:

To add a branch under the top event LOAD, place the index finger of the pick curser E on the branch
point of the success branch of BRAKE-SYSTEM directly under the LOAD top event. Click the right
mouse button to select this as a branch point. The line at the branch point will turn yellow as shown in
Figure 6.

OF-MANEUVER

Figure 6 Example of branch point editing

UICK TIP

Grid lines can be added to the Event Tree Editor to aid the user in determining top event
branch points. To add grid lines to the Event Tree Editor Screen: Select from the menu bar
View - Show Grid.
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Add a branch by either selecting the “Branch-up” button on the tool bar

or by evoking the

pop-up menu by clicking the right mouse button and selecting Add Branch Above. A third option to add
a branch is to select the branch point then, in the menu bar, click on Edit > Add Branch Above.

To delete an unwanted branch, Use the point cursor to select the unwanted branch (turns yellow).
Select Edit - Delete from the menu bar or use the pop-menu (right click) and select Delete.

Continue Steps 1 and 2 for each of the branch points in Figure 6.

Editing Top Events

At times, it may be necessary to edit, delete, or add a top event to the event tree graphic. To modify a top
event, select the top event using the Pick cursor (place the cursor on the top event and click the left mouse
button. Click the right mouse button. The Edit Event dialog box will be displayed. From this box, the
Name and Description of the event can be modified. In addition, font sizes and colors can be changed.

DESCRIPTION display height I 3 lines

R

Top Background Color

Desc Font

Edit Event K E3
Mame ———  —~Description
[ | [ oRivER avoDs =
OBSTRUCTION
= | [nitieting Event
=
— Top Attributes
MAME display wicth I 11 characters  Mame Font |

—Page Attributes

Background Color

I- Gray vl
||_| Wihite vl
Hiohlighted SEeguence Ealur I- Mawy vl
Leaf Height I 40

Line Calar

Ok

Cancel

To delete a top event, select the top event using the Pick cursor. In the menu bar, select Edit = Delete to

delete the top event.

-OR-

To delete the top event, click on the L™

To add a top event, choose the “Top” object button

v

TOF
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button in the graphical tool bar with the left mouse button.

from the graphical tool bar. The cursor will



change to the “Top” cursor. Move the cursor to the top event in the header that will follow the top event
you are adding. Click the left mouse button to add the top event. The Edit Event dialog box will be
displayed. To add a top after the rightmost top event, move the cursor to the right of the last top event
and click the left mouse button.

UICK TIP

To change the Leaf Height (i.e. spacing between the event tree branches), evoke the pop-up menu
by clicking the right mouse button anywhere on the event tree graphics screen. Increase the leaf
height by increasing the number located in the Leaf Height box. This number is a “pixel” number
so. increase the number bv increments of 10 or 20 until the desired spacing is reached.

STEP 3: Add/Edit End-States to the New Event Tree Using the Event Tree Editor

Step 3 of this section guides the user on how to add and edit end states on each of the sequences in
SAPHIRE. End states are required in order to tell SAPHIRE where to group (or bin) sequence cut sets.
On the far right of the event tree are the end-state headers. There are four header columns available for
each event tree and a column reserved for the sequence number. The default for SAPHIRE is to display
only one of the header columns. However, the user can adjust the number of sequence header columns
displayed, the text font and color, and header column titles by accessing the Edit Sequence Header
dialog box.

To adjust the Sequence Headers Dialog, perform the following steps:

1. To modify sequence header columns or activate end-state and sequence headers, chose the pick

button ah and position cursor over the any of the sequence header column fields. Click the
right mouse button. The Edit sequence header dialog box, as shown below, will be displayed.

Edit Sequence Header 7| x|

[ First I SEQUENCE-MAM | [ Third I FREGUEMCY
v Second I EMD-STATE-MAK [ Fourth I EXTRA-#1

—Page Attributes
Background Color I Wit 'I
Line Colar I- Black 'I

Highliakted Sequenee Golar I- My vl
Leat Height I 40

QK Cancel
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The four dialog boxes with a check mark are the Sequence Header columns that are currently
displayed. To activate the other Sequence Header columns, place the cursor over the check box and click
the left mouse button to add a check mark. To deactivate a Sequence Header column (i.e. not displayed
on the event tree), click on the check mark with the left mouse button to remove the check mark.

UICK TIP

To move or change the width of a sequence header, position the pick cursor over the line of the
desired column. The cursor will change to the +* cursor. Drag the mouse with the left mouse
button pressed to the desired location and then release the mouse button to set the new column
location.

To change the Sequence Header description, move the mouse cursor into a header box that is to be
change and modify the header name as desired. When finished, select the @ button.

On the far right of the event tree are the end-state headers. There are four header columns.

Each sequence branch in the event tree needs some kind of end-state. On success branches, this end-state
is usually labeled with an OK—however, it does not have to be. In SAPHIRE, if the end-state column
entry is OK, the “@” symbol, or the word “Success”—logic for that sequence will not be developed. For
an end-state with any other 24 character or less entry, sequence logic will be developed. End states are
assigned to event tree branches by accessing the Edit Sequence dialog box.

To enter the end-state names, complete the following steps:

Use the pick cursor to select sequence number 1 by moving the cursor over the number “1” and

clicking the left mouse key. The sequence header row will be highlighted with a dotted line as shown
below.
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File Edit Wiew Help
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|Sequence: | =
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With the sequence highlighted, click the right mouse button to evoke the Edit Sequence dialog box as
shown below:

Edit Sequence |

pSequence I E FFrequencyl
¥ End Statel ¥ Extra #2 |

[ Tranzfel Fort

—Page Attributes
Background Color ||_| Wyhite

Line Color I- Black

Highliahted Sequence Calar I- Blaney

Leat Height I 40

) L L

(0134 Cancel

At the top of Edit Sequence dialog box there are four available sequence information boxes, each with
check box used to evoke them for display in the event tree graphics. The fields “Sequence”, “Frequency”
and “Extra 2” are additional information boxes used to display extra text about the sequence. These fields

15



are not required to be filled. The “End State” field is the name of the sequence end-state. This field
needs to be filled in order for SAPHIRE to generate sequences. For success branches, this field can be
either OK, @, or Success.

For sequence number 1, move the mouse cursor to the End-state field and click the left mouse
button. Since this is a success branch, type in the work “OK” in this field. Make sure this field is
checked ([) to ensure that this sequence end-state appears in the event tree graphics.

Highlight sequence number 2. This is a down (or failure) branch and results in some consequence.
Click the right mouse button to obtain the Edit Sequence dialog box. Enter in to the End State box the
end-state name RELEASE and ensure that this sequence box is checked. Click @ when completed.

Repeat step 3 for the remaining 3, 4, 5, and 6 sequence numbers. Make sure that all the sequences
that end with an “up” branch are labeled OK while the sequences that end with a “down” branch have an
end-state labeled RELEASE.

STEP 4: Save the Event Tree and Exit from the Event Tree Editor
Step 4 of this section saves the event tree graphics in SAPHIRE database and exits the user from the event
tree editor. To save the event tree graphics and exit from the event tree editor, perform the following
steps:
=

When all the sequence end states are labeled, click on the save button L= in the graphical tool
bar or click on File > Save in the menu bar. This will save all modifications under the original event
tree name.

If a new file name is desired, click on File = Save As and type in the new file name in the File Name
box. The event tree name and the file name do not need to be the same.

To exit the event tree editor, click on File = EXit. This will return the user to the Event Tree List
box.

UICK TIP

For modifying larger event trees, the zoom feature can be accessed. To access zoom, click on E .
Move the zoom cursor to the area of the event tree that needs to be zoomed. Click the left mouse
button to zoom in and the right mouse button to zoom out.
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2.3 Lesson 3 — Building Fault Trees

In Lesson 2.3, the user is introduced to fault tree development, SAPHIRE fault tree symbols, and
SAPHIRE fault tree modeling conventions. The user will create the basic fault trees used as top events in
the “OBSTRUCT” event tree. For this lesson, it is necessary to create three fault trees (BRAKE-SYS,
OP-MANEUVER, and LOAD) and save them in the SAPHIRE database.

The top event that were entered in the OBSTRUCT event tree are further developed as fault trees in this
section. Fault tree construction allows a logical structure to be developed that is used to analyze possible
failures and to calculate the probability of failure.

The following two sections below reviews the fault tree symbols used in building fault trees in SAPHIRE.

2.3.1 Basic Event Symbols

This section reviews the basic event symbols in SAPHIRE used in fault tree construction. All the
symbols below are buttons and are located in the graphical tool bar of the Fault Tree Graphical Editor.

This symbol also represents a basic event such as a hardware failure, human error or an adverse
condition.

This symbol also represents a basic event. The system provides a box to contain description text.

This symbol is used to represent a table of basic events. This system is used for space saving
layouts.

Represents the undeveloped event. The undeveloped event is treated as a basic event but
represents an event that requires further development (i.e. a possible system).

» (¢ Bl |e

Represents a “house event”. A house event is used to denote a guaranteed failure (set to “True”)
or a guaranteed success (set to “False”). House events are generally used to turn specific gates or
logic “on” or “off”.

K]

Represents an undeveloped transfer. This symbol is treated as a basic event. However, it
indicates that the event is complex enough that it may require future development into it’s own
fault tree logic.

2.3.2 Fault Tree Logic Gate Symbols

This section reviews the logic gate system in SAPHIRE used in fault tree construction.

|E| Represents an AND gate. The logic operation for this gate requires all inputs into the AND gate
must occur for failure to occur.
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Represents an OR gate. The logic operation for this gate requires only one of the total number of
inputs into the OR gate to occur for failure to occur.

. JE |

Represents an “N-OUT-OF-M” gate (or N/M gate). The logic operation for this gate requires that
N of the M inputs into the gate must occur for failure to occur. For example, for a 2/5 gate, any
combination of 2 of the 5 input events must occur for a failure to occur.

tal

Represents an INHIBIT gate. The inhibit gate is a special type of AND gate. The logic operation
for this gate requires that in the presence of the enabling condition (or conditioning event), and a
single input fault occurs then a failure has occurred.

C |

This symbol represents a NAND gate (or NOT AND gate). The logic output of a NAND gate
occurs if any one of the inputs does not fail (success). The NAND gate is the same as an OR gate
with complimented events (success events) for the inputs.

=

This symbol represents a NOR gate (or NOT OR gate). The logic output of a NOR gate occurs if
none of the inputs fail. The NOR gate is a logically the same as a AND gate with complimented
events (success events) for the inputs.

L]

This symbol represents a TRANSFER gate. The transfer gate indicates that logic is continued
from some other location. The location could be a new separate fault tree (top event) or a gate
from some other location in the same fault tree.

This symbol is used to indicate where a transfer has taken place in the fault tree. It has no logical
or functional purpose and is only used for graphical purposes.

[H

This symbol is a descriptive text box. It is used for additional information to be added to the
structure of the fault tree.

=
=y
m

This symbol allows for the creation of connecting lines to connect the gates and basic event
together. The connecting lines can be solid or dashed and can be drawn at various angles.

2.3.3 Creating a Fault Tree in SAPHIRE

Fault trees, or fault tree logic may be created with two methods in SAPHIRE. The first method is with
the use of the Fault Tree Logic Editor. The fault tree logic editor is a convenient tool for quickly editing
fault tree logic and entering gate and basic event data. Fault tree gate descriptions can be entered from
this editor as well as basic event descriptions and data. The Fault Tree Logic Editor will not be discussed
in example problem. Details for the fault tree logical editor can be found in the Technical Reference
Guide. The second method to create fault tree is with the use of the Fault Tree Graphical Editor. This
method will be discussed in detail for the example problem and will be used for the construction of all
fault trees.

Figure 7, Figure 8, and Figure 9 illustrate three fault trees, BRAKE-SYS, OP-MANUVER, and LOAD,
respectively. These fault trees will be created and will be used as the three system top events in the event
tree created in the previous section. The following three fault trees will be created in this section:
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TRUCK AIR

BRAKES
FAIL
BRAKE-SYS
I 1
OPERATOR BRAKING
FAILS TO APPLY COMPONENTS
BRAKES FAIL
O 5.0E-1
OP-HEP-BRK BRAKE-SYS-MECH
I 1 1
FAILURE OF FAILURE OF WHEEL BRAKES
AIR COMPRESSOR AIR RESERVOIR FAIL
1.0E-4 3.0E-5
BRK-AIR-FC-COMP BRK-AIR-FC-RESV BRAKE-SYS-WHL
I 1
WHEEL BRAKE WHEEL BRAKE
SYSTEM 1 SYSTEM 2
BRAKE-SYS-WHL1 BRAKE-SYS-WHL2
I 1 1 I 1 1
BRAKE VALVE 1 BRAKE BRAKE DISK 1 BRAKE VALVE 2 BRAKE BRAKE DISK 2
FAILURE CYLINDER 1 FAILURE FAILURE CYLINDER 2 FAILURE
FAILURE FAILURE
1.0E-3 4.0E-3 2.0E-4 1.0E-3 4.0E-3 2.0E-4
BRK-VLV-CC-1 BRK-CYL-FC-1 BRK-DSK-FC-1 BRK-VLV-CC-2 BRK-CYL-FC-2 BRK-DSK-FC-2

BRAKE-SYS - TRUCK AIR BRAKES FAIL

2002/12/12 Page 1

Figure 7 BRAKE-SYS fault tree

OPERATOR
AVOIDS
OBSTRUCTION

[

OP-MAI\IIEUVER

OPERATOR
MANEUVERS
TRUCK

TRUE
OP-HEP-MOVE

P-MANEUVER - OPERATOR AVOIDS

2002/12112_Page 5

Figure 8 OP-MANEUVER fault tree
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|
LOAD

CONTRAINTS
FAIL
LOAD
[ + 1
LOAD DRUM PACKAGE
STRAP FAILURE
FAIL
o
LOAD_-STP WST-DRM-FC-1
I 1
LOAD SHIFTS OPERATOR FAILS
AND CONSTRAINTS TO RESECURE
LOOSEN LOAD
Q 1.0E-2 Q 4.0E-2
CON-STP-FC-DEG1 CON-XHE-XA-RESEC
LOAD - LOAD CONTRAINTS FAIL 2002/12/16  Page 2

Figure 9 LOAD fault tree
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The following steps guide the user on creating a new fault tree in SAPIRE. The three fault trees shown
above in Figure 7 through Figure 9 will be constructed using the detailed steps below.

STEP 1: Access the Fault Tree Graphical Editor
The fault tree BRAKE-SYS will be created first. To access the graphical fault tree editor in SAPHIRE,
perform the following steps:

o

Access the fault tree graphical editor by selecting the Fault Tree button ﬁ on the graphical
tool bar (5" button from the left) or click on Fault Tree from the menu bar. This will bring up a list of
fault trees in the database as shown in Figure 10. The current database for this tutorial has three fault
trees. These fault trees have no logic structure incorporated with them. They were automatically created
when the event tree OBSTRUCT was created and used these as system top events.

Fault Trees List - (PRACTICE) 2] ]
Tatal # 3 harked # 1] [ Show Sub-Trees Analysiz Type IRANDOM 'l

BRAKE 575
LOAD
OP-MANELIVER

Fault Tree hask Mazk Action

Ia ’7 &) nelide 0] Exclide Apply Mask Exit

Figure 10 Fault Trees List
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Highlight the BRAKE-SYS fault tree name and then left click to evoke the pop-up menu shown

below.
Audd Fault Tree

Edit Graphics

Edit P+ID

Edit Logic

Page Tree

Solve

DQuantify »
Uncertainty

Cut Sets 3
Dizplay »
YWiews Results

Time D ependent

Highlight Edit Graphics in the pop-up menu. A blank fault tree graphical editor screen will appear as
shown in Figure 11. All the available graphical features need to complete any fault tree are displayed at
the top of the editor in the tool bar.

[ S APHIRE e W=
Help

+ Fault Tree Editor - BRAKE-5YS_DLS
File Edit View Search HelD

Help

W lcome b E.E _I

Figure 11 Graphical Fault Tree Editor
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STEP 2: Selecting and Arranging Fault Tree Logic Symbols
The symbols in fault tree BRAKE-SYS will be added. To add symbols to the fault tree, perform the
following steps:

To begin building the logic for the fault tree, select the desired object button from the tool bar. For

the fault tree BRAKE-SYS, the top gate is an “OR” gate. Move the cursor to tool bar and select the ?I
tool bar button (click the left mouse button). The cursor will change to a “OR” gate ghost cursor. Move
the cursor to the desired location on the editor page and click the left mouse button to place the object on
the page. The right mouse button terminates the selected ghost shape option and returns the cursor to the
original “pick cursor”. To add additional selected objects, position the ghost cursor at the desired location
in the editor and click the left mouse button. The ghost cursor will remain the selected object until
another object is selected or until the cursor is terminated with a right click.

NOTICE: The placement of the fault tree symbols in the graphical editor is NOT a “drag and drop”
procedure. Selecting the object and then holding down the left mouse key WILL NOT drag the object
over to editor screen.

Fault tree BRAKE-SYS shows that underneath the top gate is a single basic event and another OR
gate. If the OR gate ghost cursor is still active, simply place the cursor at the desired location in the
editor, and click the left mouse button. To add the “BASIC EVENT” symbol, move the cursor back to

the tool bar and select the If‘ tool bar button. The cursor will change to a “BASIC EVENT” ghost
cursor. Move the cursor to the desired location on the editor page and click the left mouse button to place
object on the page.

STEP 3: Connecting Fault Tree Symbols with Lines

After the various logic symbols in the fault tree have been added, the logic gates and basic events must be
linked together to form logical branches using connecting lines. To add connecting lines to the fault tree
BRAKE-SYS perform the following steps:

Select the LINE button IE from the fault tree editor graphical tool bar.

Move the “LINE” ghost cursor to the desired starting location and press and hold the left mouse

button. Drag the line cursor to the ending point of the connection line and release the left mouse button.

The endpoint location can be anywhere in editor screen to lengthen, shorten, or change the direction of

the line. Figure 12 illustrates the three of the symbols and their connecting lines for fault tree BRAKE-
SYS.
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Ml Fault Tree Editor - BRAKE-SYS.DLS

Figure 12 Addition of Connecting Lines for Fault Tree BRAKE-SYS

UICK TIP

To move or reposition a fault tree symbol, place the “pick” cursor IE over the object to be moved.
Press and hold on the left mouse button and move the highlighted object to the new, desired
location.

STEP 4: Adding Symbol Definition

After the various logic symbols in the fault tree have been added and connecting lines between the
various symbols, the final step in created the fault tree is to label the gates and basic events with the
appropriate names and descriptions. To add or edit symbol attributes to the fault tree BRAKE-SYS
perform the following steps:

In the fault tree editor, select the desired shape to be modified my placing the “pick” cursor over
the object and clicking the left mouse button (the object selected will be highlighted with a dotted line.)
For this example, click on the top OR gate of the fault tree, BRAKE-SYS. Click the right mouse button
to evoke the drop-down menu shown below. Highlight EDIT and click the left mouse button. [An
additional approach is from the Fault Tree Editor menu bar, Select Edit > Attributes...]

24



Edit Database

Preferences

Zoom Selected

The “Shape Definition” window appears as shown in Figure 13. From this window, the user can
change the shape type (example: change an OR gate to an AND gate) and color, add/modify shape names
and descriptions, adjust text justifications, and change the connecting line characteristics.

SAPHIRE automatically assigns default names to fault tree gates, basic events, and tables. These are
usually re-named by the user. SAPHIRE does require that top gate in a fault tree must be identical to the
name given to the fault tree. To change the gate name, enter the new gate name, BRAKE-SYS, in the
Name entry box located at the top of screen. In addition, the description, “TRUCK AIR BRAKES
FAIL”, can be entered in the Description entry box

Click on when finished to return to the Fault Tree Editor screen.

Repeat the naming procedures above for all the fault tree gates and basic events shown in Figure 7
through Figure 9.
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Cancel
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Name |BRAKE-SVE
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Auta Ve | Font Text Justification
TRUCH AR ;I Horizontal ertical
BRAKES FAIL
| " Lett 1 Top
{* Certer {* Miciclle
w
> LIJ ™ Right = Bottom
—Attributes

TRUE K AIR
BRAKESR FAIL

Figure 13 Shape Definition Entry Box

STEP 5: Ending the Fault Tree Editing Session

When the fault tree is complete with the desired attributes, the fault tree can be saved and the fault tree

editor exited with the following steps:

)
To save the fault tree graphic, click on the Save button IE located in the graphical tool bar
(second button from the left). Or — From the Fault Tree Editor menu bar, select File > Save as...

For fault tree, BRAKE-SYS, save the file under the name “BRAKE-SYS”.
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Savein | PRACTICE =l + =F E-

EBRAKE-SYS.DLS

Fil= narns: EI H. K E - 5 vl Save I
Save as lwpe: [Fault Tree Fies<=DLS> -] Cancel |

—

To exit without saving, in the Fault Tree Editor menu bar: Click on File = Exit. Choose No to
quit without saving.

Repeat all the steps outlined in this section for the remaining fault trees OP-MANEUVER and LOAD.
When completed, the user now has fault tree logic for all the top events for event tree, OBSTRUCT.

2.4 Lesson 4 - Basic Event Information

In this lesson, the user is introduced to basic event data entry into SAPHIRE. For the example problem,
the lesson requires that the user input the values shown in Table 1.

During the process of event tree and fault tree creation that was completed in Sections 2.2 and 2.3,
SAPHIRE added all the basic event names, gates, event tree top events (i.e. fault trees), and initiating
events. However, failure rates or probabilities and initiating event frequencies are not included and must
be entered into SAPHIRE. In this lesson, failure data are entered into the “base case” for use by
SAPHIRE during an analysis. SAPHIRE separates the data in a project database into two separate parts:
base case and current case. Base Case data is stored in the data base files as a “permanent” record.
Current Case data is used to perform an analysis (e.g., cut set generation and quantification).

For the OBSTRUCT example, the data values will be added to SAPHIRE database to the basic events
listed in Table 1. Note that the failure rates used are for demonstration purposes only.

27



Table 1 Basic Event Data Values*

Basic Event Name Failure Uncertainty Error Factor
Probability | Distribution

BRK-AIR-FC-COMP 1.0E-04 Lognormal 5
BRK-AIR-FC-RESV 3.0E-05 Lognormal 3
BRK-CYL-FC-1 4.0E-03 Lognormal 5
BRK-CYL-FC-2 4.0E-03 Lognormal 5
BRK-DSK-FC-1 2.0E-04 Lognormal 10
BRK-DSK-FC-2 2.0E-04 Lognormal 10
BRK-VLV-CC-1 1.0E-03 Lognormal 5
BRK-VLV-CC-2 1.0E-03 Lognormal 5
CON-STP-FC-BRK 1.0E-01 Lognormal 10
CON-STP-FC-DEGI 1.0E-02 Lognormal 10
CON-XHE-XA-RESEC 4.0E-02 Lognormal 5
IE-OB 1.0 Lognormal 3
OP-HEP-BRK 5.0E-01 Lognormal 10
OP-HEP-MOVE 1.0 Lognormal 10
OP-MANEUVER 1.0 Lognormal 10
WST-DRM-FC-1 3.0E-02 Lognormal 5
WST-DRM-FC-2 1.0E-02 Lognormal 5

* These values are for demonstration purposes only and may not be applicable for any
actual application.
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2.4.1 Entering Basic Event Information as Base Case Data

Basic event data loaded or entered into SAPHIRE is placed into the project database as base case data.
The basic event data in Table 1 will be entered into the SAPHIRE database. To access the graphical fault
tree editor in SAPHIRE, perform the following steps:

To enter or modify basic event data, select Modify from either the graphical tool bar or the menu
bar.

Then select Basic Events. A listing of all the basic events in the database will be displayed as
shown in Figure 14.

Edit Events - (PRACTICE)

ame

Description

Zix]

=FALSE=

=INIT=

=PASS=

=TRUE=
BRAKE-ZYS
BRK-AIR-FC-COMP
BRK-AIR-FC-RESY
BRK-CYL-FC-1
BRK-CYL-FC-2
BRK-DSK-FC-1
BRK-DSK-FC-2
BRK-VLW-CC-1
BRK-VLW-CC-2
COM-STP-FC-DEG1
COM-¥HE-XA-RESEC
IE-0B

LOAD
OP-HEP-BRK
OP-HEP-MOWE
OP-MANELWER
WEST-DRM-FC-1

System Generated Success Event
System Generated Initisting Event
System Generated Ignore Event

System Generated Failure Event

TRUCH AR BRAKES FAIL

FAILURE OF AR COMPRESSOR
FAILURE OF AlR RESERWCIR

BRAKE CYLIMDER 1 FAILURE

BRAKE CYLINDER 2 FAILLURE

BRAKE DISH 1 FAILURE

BRAKE DISH 2 FAILURE

BRAKE %ALWE 1 FAILURE

BRAKE % ALWE 2 FAILURE

LOAD SHIFTS AMD COMSTRAINTS LOOSEN
COPERATOR FAILS TO RESECURE LOAD
IMITIATING EVENT: OBSTRUCTION M ROACWAY
LOAD COMTRAINTS FAIL

COPERATOR FAILS TO APPLY BRAKES
CPERATOR MANELIWVERS TRUCK
CPERATOR ANMOIDS OBSTRUCTION
DRUM PACKAGE FAILURE

Right Click for Menu Options.

Crosz-Reference Eetmove Unused Exit

Figure 14 Basic Event Listing

Highlight the basic event to be modified (For this first example, highlight the basic event BRK-
AIR-FC-COMP) and then click the right mouse button. Select Edit from the drop down menu. [Or
Double Click on the basic event to be modified]

The Modify Event screen appears as shown in Figure 15. From this window, all basic event data
including uncertainties can be entered. The Modify Event screen has “Tab” buttons across the top. The
Event tab is accessed automatically when the Modify = Basic Event option is implemented. This tab is
used to input all failure and uncertainty data. The other tabs are used for adding other descriptive
attributes, process flags and other advanced features. Specific details for these features can be found in
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the SAPHIRE Reference Manual.

Modify Event EE |

Event |.-'1'-.ttril:|utes| Process Flagl Templatel Transfu:urmatiu:unsl Llnu:ertaint_l,ll

Event Mames

Primary RE-AIR-FC-COMP Alternate | BRE-AR-FC-COMP

Description I FAILURE OF AlR COMPRESSOR

Random Failure Data Uncertainty Data

Type |1 - Probability || Tyre ||_ - Log Marmal =
hean Failure Prokbakbility ]m
Lambcla ]M Error Factor M
Tau ]M ?
Mis=ion Time ]M Cotrelation Class I—

k. I Cahcel

Figure 15 Modify Event Window

The left side of the Modify Event Window is where the Random Failure Data is entered. This area
contains the calculation Type and is equipped with a drop down menu system for access to the various
calculation types. For the basic event, BRK-AIR-FC-COMP, the calculation Type should be “1” (the
default type). The four data entry boxes below the calculation Type are use to enter the various failure
data depending on the calculation type used. For calculation Type 1, only the Mean Failure Probability
value is required. From Table 1, enter the value, 1.8E-5 into the Mean Failure Probability box.

The right side of the Modify Event Window is where the Uncertainty Data is entered. This area
contains uncertainty distribution Type and is equipped with a drop down menu for access to the various
distribution types. For the basic event, BKR-AIR-FC-COMP, the uncertainty Type is “L: Log Normal.”
The entry boxes below the uncertainty data type are used to enter the various uncertainty data. From
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Table 1, enter the value “5” into the first Error Factor box. A statistical Correlation Class number is
not required for this example.

Click on the button when all the data is entered.

Repeat all the steps outlined above (Steps 1 through 5) for the remaining basic events listed in Table 1.
When completed, the user now has failure and uncertainty data for all the basic events used by the fault
trees in the OBSTRUCT project.

2.4.2 Generating Basic Event Data to the Current Case

Once the base event rate information data is entered into SAPHIRE as base case data, it must be copied
over (or transferred) to current case data. SAPHIRE only uses current case data for analysis. The
Generate option is used to transfer base case data to current case data.

UICK TIP

SAPHIRE has the ability to create “Template Events”. With template events, basic event
information, such as failure rate and uncertainty data, can be easily copied over to other basic events
that require identical data.

To create a template event or make any event a template event, select the Attributes tab, located at
the top of the Modify Event box. Move the cursor to the “Special Use Flags” area and select
Template Event. This flag tells SAPHIRE that this basic event is a template event and rate
information can be transferred to other basic events.

Move the cursor up to Template tab and click the left mouse key. The template characteristics that
are to be applied to other basic events are checked. By default, all of the template event
characteristics are check. To check or uncheck a already check box, click on the selection box.
Once all desired characteristics are check, click on OK.

To apply the rate information of the newly created template event to other basic event, access
Modify > Basic Event and highlight the basic event that is to have the data applied. Click the
right mouse button and select Modify. Then click on the Template tab. Access the Template
selection box with the drop down menu button. Select the desired template event name and click
OK.

The rate information and attribute data shown, will then be applied (or copied over) to the basic
event.
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To generate event data, perform the following steps:
B
G
Select the Generate Button 'snerate | from the graphical tool bar or select “Generate” from the menu
bar.

The Generate screen, as shown below will be displayed. This screen is used to display and activate
charge-sets. Currently, there are no change sets in the OBSTRUCT database.

Change Set Name Change Set Description
Default Mizzion Time I 2. 400E+001 Right Click for Menu Options
Class | Single | Report Generate | Exit I

Click on the Generate button. SAPHIRE will exit this screen automatically when completed.
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2.5 Lesson 5 - Graphical Output

Lesson 5 guides the user on how to print event trees and fault trees. In Lesson 5, the user will print event
the event tree, OBSTRUCT, to a printer and print the three fault trees (BRAKE-SYS, OP-MANEUVER,
and LOAD to a printer. The lesson also briefly describes how to export SAPHIRE graphics in the form
of metafiles to be used in other software packages.

Once the event tree and fault tree logic have been developed and saved, the graphical logic representation
can be printed directly to a printed or exported to a graphical output file capable of being loaded into
other software packages.

2.5.1 Printing Event Tree Graphics

Printing an event tree can be accomplished in two ways: 1) from the event tree graphical editor or 2)
using the Report feature of SAPHIRE. To print an event tree from the event tree graphical editor
(access the event tree editor by selecting Event Tree (highlighting the OBSTRUCT event tree and right

click) > Edit Graphics. From the graphical tool bar, select the Print button 5‘ Select the desired
printer from the print screen and click the Print button.

To print an event tree using the Report feature, perform the following steps:

=
Click on the Reports button LFeets | [ocated on the right side of the graphical tool bar (or click on
Reports from the menu bar).

Reportsviens N |

—Data Type
™ Project

—Report Type —Sub Type

 Aftributes

{~ Basic Events
{~ Fault Tree
¥ Evert Tree
" End State

{ Sequence
" Gate

{" Histogram

" User Info

" Initisting Events
{~ Cross Reference

 Custom

Frocess |

Exit |
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From the Reports Menu, click on Event Tree in the Data Type field and click on Graphic in the
Report Type ficld. When complete, click on the Process button or the EXit button to exit without
printing.

Select from the Event Tree Graphics window, the event tree OBSTRUCT and click on the Print
button. To export as a Windows metafile, click on the Export button.

Event Tree Graphics - (PRACTICE) 7] |

€] Ewvent Trees

 Tutorial Event Tree for Tru

Export | Prirt | Exit |

From the print window, select the desired printer and click on the Print button.

2.5.2 Printing Fault Tree Graphics

Printing a fault tree can be accomplished in two ways: 1) from the fault tree graphical editor or 2) using
the Report feature of SAPHIRE. To print an fault tree from the fault tree graphical editor (access the
event fault editor by selecting Fault Tree (highlighting the desired fault tree to print and right click) >

Edit Graphics. From the graphical tool bar, select the Print button 5‘ Select the desired printer
from the print screen and click the Print button.
To print a fault tree using the Report feature, perform the following steps:
=
Click on the Reports button [_reets | Jocated on the right side of the graphical tool bar (or click on
Reports from the menu bar).

From the Reports Menu, click on Fault Tree in the Data Type field and click on Graphic in the
Report Type ficld. When complete, click on the Process button or the EXit button to exit without
printing.
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2 |

—Data Type —— —Report Type —aub Type
" Project " Summary
O sttributes " Logic

{~ Basic Everts

% Fault Tree

" Evert Tree " Importance

" End State " ¥ Reference Fault Tres

" Seguence ("~ ¥ Reference Sub-tree

 Gate = Custom

£ Histogram

= User Info Process | Exit |

Select from the Fault Tree Graphics window, the desired fault trees to be printed. To select all the fault
trees, click on the BRAKE-SYS fault tree and hold down the left mouse button while dragging the mouse
to the end of the list. Release the mouse button and click on the Print button located at the bottom the
Graphics Reports Window. To export as a Windows metafile, click on the Export button.

Graphics Reports - {PRACTICE) - (PRACTICE)

Mame Description

BRAKE-S%S <L R BRAKES FA

L':;. ] A0 CORT A
CIP-f&RELNER: QPERATOR A&° BETRUCTION

Export Prirt Exit
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2.6 Lesson 6 — Generating Fault Tree Cut sets

In Lesson 6, the user will learn how to generate and quantify fault tree cut sets, view fault tree cut set, and
produce a report on fault tree cut set results. For this lesson, cut sets will be generated for the three fault
trees (BRAKE-SYS, OP-MANEUVER, and LOAD) created in Lesson 3.

After the fault tree structure, or logic, has been developed and saved, fault tree cut sets can be produced
and quantified. A cut set is a set of basic event combinations that, if they occur together, will cause a
failure. A minimal cut set has no other cut set a subset. When generating fault tree cut sets, SAPHIRE
reduces the and/or fault tree logic to minimal cut sets and uses the numerical rate values of the basic event
data to calculated the probability of failure of the top event for the fault tree being quantified.

2.6.1 STEP 1: Generating Fault Tree Cut Sets
To generate new fault tree cut sets for the fault tree BRAKE-SYS, perform the following steps:
Select the Fault Tree button from the Graphical Tool Bar.

Highlight the fault tree, BRAKE-SYS. Click the right mouse button to evoke the pop-up menu and
move the highlight cursor down to Solve.

Fault Trees List - (PRACTICE) 2]

Total # 5 harked # 1 [~ Show Sub-Trees Analysis Type IRANDOM -l

WS TRUCK AlR BRAKES FAIL
LOAD LOAD COMTRAINTS FAIL
CP-MANELVER CPERATOR AYVOIDS OBSTRUCTION

Add Fault Tree

Edit Graphics
Edit P+ID
Edit Logic
Page Tree

Quankify 3
Uncertainty

Cuk Sets 3
Display 3

View Results

Time Dependent

Fault Tree Mask ask Action

|a ’7 % nolude € Exclude Apply Mask Exit
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UICK TIP

To highlight all fault trees in the Fault Tree List (to generate cut sets for all the listed fault trees),
select the M button. This button will highlight all the fault tree names in the list.

The Cut Set Generation window as shown in Figure 16 will be displayed. If the “Cutoff by
Cut Set Probability” box is check (default), then those cut sets with quantified value below the specified
cutoff value (located in “Global Cutoff Value” entry box) will not be retained. It the box is not checked,
then all cut sets will be retained. Click the OK button to accept the default cut set generation and
truncation settings.

Cut Set Generation 2|

Cutoff by Cut Set Probakility! [ Fault Tree & Global = Global Cutoff Yalue 1 000E-0135

Cutoft by Event Probahility - Min = Cutoff YWalue | E----
Cutoff by € Size  Zone % Mone = Cutoff Walue | 3
Starting Gate Mame I Flag Set Mame I ;I

Auto Apply Recovery Rules [

MOTE: To perform Event Probakility truncation you must also specify
Cut=et Probahbilty truncation and the associated cutoff value.

(8] Cancel |

Figure 16 Cut Set Generation Screen

The Cut Set Generation Results screen will be displayed as shown below in Figure 17. This screen
shows the number of cut sets generated and minimal cut set upper bound approximation result. Click on
the OK button to continue.
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Cut Set Generation Results I

Marme: BRAKE-SYS
Elapsed Time: 00:00:00.010
cut Sets UpperBound
Size #
1 3 5.001 E-001
2 El 2. 704E-0035
& L E----
4 o — E----
5 L E----
6 o — E----
7 o — E----
g L E----
9 o — E----
10 e — E----
=10 o — E----
Total 12 5.001E-001

Figure 17 Cut Set Generation Results Screen

2.6.2 STEP 2: Displaying Fault Tree Cut Sets

To display the new fault tree cut sets for the fault tree BRAKE-SY'S, perform the following steps:

From the Fault Tree List screen, highlight the BRAKE-SYS fault tree.
#**NOTE*** The “c” located in from the fault tree name indicates that there are now “current case” cut
sets for fault tree, BRAKE-SYS.

Click the right mouse button to evoke the pop-up menu and select Display - Cut Sets as shown in
Figure 18.

The cut sets generated for fault tree, BRAKE-SYS are now displayed as shown below in Figure 19.
From this screen, details of each cut set and the minimal cut set upper bound approximation can be

observed.

Select the Exit button when complete.
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Total # 3 Marked ¥ 1 I Show Sub-Trees Analysis Type IRANDOM I

[oaD fdd Faule Tree INTS Faull

OP M NELWVER: Edit Graphics OIDS OBSTRUCTION
Edit P+ICr
Edit Logic
Page Tree

Solve

Quantify »
Uncerkainkty

Cuk Sets 3

Wiew Results Comparison
Importance »

Uncertainky

Time Dependent

Fault Tree Mask Mask &ction

|x ’V &+ [nclude € Exclude Apply Mask Exit

Figure 18 Displaying cut sets screen
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Selected Cut Sets - (PRACTICE, BRAKE-SYS) JEd S

blin Cut S.001E-001  Mum 12 Thiz List===  5.001E-001 10000 %% Mum 12

Cut Set %

. Frequency Total Everts
1 5.000E-001 99.95 ZP-HEP-BRE
2 1.000E-004 0.0z BRk-AIR-FC-COomP
3 3.000E-005 0.01 BRF-AIR-FC-RES
4 1 G00E-005 0.00
5 4 000E-006 0.00 BRK-CYL-FC-1, BRE-%LW-CC-2
5 4 000E-006 0.00 BRK-CYL-FC-2, BRE-%LY-CC1
7 1 000E-006 o.ao BRKE-%WL%-CC-1, BRH-WLYW-CC-2
g S.000E-007 0.00 BRE-CYL-FCZ-1, BRK-DESK-FC-2
=] S.000E-007 0.00 BRK-CYL-FZ-2, BRK-DSH-FC-1
10 2.000E-007 0.00 BRE-DSH-FC-1, BRE-%LY-CC-2
11 2.000E-007 0.00 BRK-DSK-FC-2, BRK-WLW-CC-1

12 4. 000E-008 0.o0 BRK-DSK-FC-1, BRK-DSH-FC-2

a| | »

Slice By Importance
_oex | o | { vomal | sas | comvo |
Cther List | e | Eeport I Save | Exit

Figure 19 Selected Cut Set Viewer

2.6.3 STEP 3: Reporting Fault Tree Cut Sets Results

To generate report results for the new fault tree cut sets for the fault tree BRAKE-SYS, perform the
following steps:

From the Cut Set Viewer screen shown in Figure 2-16, click on the Report ﬂl button.

The Sort/Slice Cut Set Report screen is displayed as shown below.
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Repork n

Report Title:
| SertiSlice Cut Set Report
Report Options

(® Print Presviesn ™ Print Slice Qualifications
" Print (Default Prirter) ™ Include Evert Detail
" File |
Ok Cancel |

Click on the Print radio button to send the report to a printer or click on the File radio button and
type in a desired file name to print the report to file (in text form). Click on the Ok button to complete the
report function.

An additional option to obtain a cut set report is through the Reports feature of SAPHIRE. To obtain a

fault tree cut set report through the Reports feature, click the Reports button IM‘ in the Graphical
Tool Bar. Select from the radio buttons, Fault Tree, for Data Type and Cut Sets for Report Type as
shown below.

Reports Menu ﬂ E
—Data Type———— Report Type———————————————————  —Sub Type

i Project i Summary

 Atributes " Logic

™ Basic Events ™~ Graphic

" Fault Tree i Cut Sets

{~ Ewert Tree {~ Importance

{~ End State {~ ¥ Reference Fault Tree

7 Sequence i~ ¥ Reference Sub-tree

i Gate " Custom

i~ Histogram

" User Infa Process Exit

Click the Process Button.

The list of available fault trees is displayed. Select the BRAKE-SYS fault tree and click the Cut Set
Button.
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Fault Tree Cut Sets - (PRACTICE) 2]

= Analysis Type IRANDOM vI
i Current e Baze Bl i

kame

Description

SN TRUCH AlR BRAKES FAIL
LoaD LOAD COMTRAINTS FaIL
OP-MANELUVER CPERATOR ANWOIDE OBSTRUCTION

Cut Set I GQuartified Detailed Exit

The Cut Set Report Option screen is displayed. With this screen, the number of cut sets can be
specified (i.e. Top 10 cut sets) and the ability to include basic event probabilities is available. If the
default values are sufficient, click the OK button. Select Print to send the report to a printer.

2.7 Lesson 7 — Fault Tree Uncertainty Analysis

In Lesson 7, the user will learn how to perform an uncertainty analysis in SAPHIRE for fault trees.
Uncertainty analysis calculates the variability of a fault tree top event probability resulting from
uncertainties in the basic event probabilities. SAPHIRE provides two uncertainty analysis techniques:

Simple Monte Carlo Sampling. This technique makes repeated quantifications of the system cut
sets using each random variable sampled from the basic event uncertainty distributions.

Latin Hypercube Sampling. This is a stratified sampling technique, with the random variable
distributions divided into equal probability intervals.

SAPHIRE supports the following basic event distribution types:

Distribution Code Parameter
Blank (Use point estimate value only)
Lognormal L Error factor
Normal N Standard deviation
Beta B B in Beta(a, b)

Dirichlet D Beta value of success branch
Gamma G rinI'(r)

Chi-squared C Degrees of freedom
Exponential E (none)

Uniform U Upper end point

Histograms H Histogram number
Maximum Entropy M Lower and upper end point
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Seismic S Betar, Betau

Constrained (0] (none)

Noninformative

Triangular (version 7 T Upper and lower endpoints
only)

For the OBSTRUCT project, the basic events only implemented the “Lognormal” distribution. For
additional information on the uncertainty analysis capabilities of SAPHIRE, please refer to the SAPHIRE
Technical Reference Guide.

For this example, the fault tree BRAKE-SYS will be used to perform an uncertainty analysis. To perform
a fault tree uncertainty analysis, perform the following steps:

Select from the Graphical Tool Bar, the Fault Tree Button lm‘

From the Fault Tree List shown below, highlight the BRAKE-SYS fault tree and click the right
mouse button to evoke the pop up menu. Move the mouse highlight cursor to Uncertainty and click the
left mouse button. If more than one fault tree is selected, the uncertainty will be calculated for each fault
tree highlighted.

Fault Trees List - {(PRACTICE) 21 x|
Total # 3 Marked # 1 I~ Show Sub-Trees Analysis Type IRANDOM -I

CK AR BRAKES FAIL

add Faulk Tree

LoaD CONTRAINTS FAIL
OP-MAMEL  Edit Graphics ATOR AVOIDS OBSTRUCTION
Edit P+ID
Edit: Logic
Page Tree
Solve
Quantify »

Uncertainky

Cuk Sets L3
Display »
Wigw Results

Time Dependent

Fault Tree Mask

Mask Action
I* ’7 % Include € Exclude Apply Mask Exit
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The Uncertainty Calculation Values screen will be displayed. Enter the uncertainty
calculation values given below.

Uncertainty Calculation ¥alues 2 I
Mumber of samples (=99999) 5000
Seed for random number generatar 543521

Urncertainty method

Ground Accelerstion Level
" Latin Hypercube I j
= Monte Carlo

Intermediste Values
Output Yalues [

File Mame I

ok Cancel |

Number of samples (the larger the number, the more accurate the results) = 5000
Seed for random number generator = 54321
Uncertainty method = Monte Carlo (this is the default method)

Click the OK button when all the values are entered.

Uncertainty results will be displayed, as shown below, briefly on the computer screen following the
uncertainty calculation.

Matne BRAKE-ZYZ

Random Seed 54321 Events &l

Sample Size S000 cut Sets 12

Poirt estimate 5.001 E-001
Mean “alue S.001E-001
£th Percertile “alue S .000E-001
Median “alus S.001E-001

S5th Percertile Y alue S.002E-001

Minimum Sample Yalue 5. Q00E-001

Maximum Sample Yalue 5 .0039E-001

Standard Deviation B.026E-003
Skewness 5.855E+000
Hurtoziz -1 27E+001
Elap=sed Time 0o0:a0: a0 . 730

Uncertainty results for each fault tree can also be displayed from selecting the Fault Tree button on the
Graphical Tool Bar and then selecting Display = Uncertainty.
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[Foule Trees st — (PRACTICE) |
Total # 3 Marked # 1 ™ Show Sub-Trees Analysis Type IRANDOM vl

LOAD AEORER ES COTAINTS FaIL
OP-MAREL Edit Graphics RATOR ANOIDS OBSTRUCTION

Edit: P+ID

Edit: Logic

Page Tree

Salve

Quantify 3

Unicertainky

Cuk Sets 3

Cut Sets
Yiew Resulks Zomparison

) Importance  »
Time Dependent

Fault Tree Mask Mssk Action

|a ’7 € [nciude £ Exclude Apply Mask Exit

The System Uncertainty Screen appears as follows:

Baze

Mean - E-—-- Median ~ -——-- E-——- Mirmcut - E-——-
Std. Dev - [E=—x Skewness - [Ee—— Kurosis  -————-- [Ee——
ath%e - E---- dinimum - E---- Seed -
as5th % [Ee—x Mlaitmum - [Ee=— Samples -

Size Cutoff - Probahility Cutaff  aeeee E----

Currert

Mean 5.001E-001 Median 5.001E-001 hlincut 5.001E-001
Sted. Dew B .026E-005 Skewness  3.955E+000 Kurtosis -1 127E+001
Sth % 5.000E-001 Minirmum S5.000E-001 Seed S4321
95th % 5.002E-001 Ml=xirmum 5.008E-001 Samples S000

Size Cutoff - Probahility Cutoff 1.000E-015
urrent Guartile Walue :I Basze Quantile Yalues Exit
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2.8 Lesson 8 — Generating Event Tree Cut Sets

In Lesson 8, the user will learn how to generate and quantify event tree (or sequence) cut sets, view
sequence cut sets, and produce a report on the sequence cut set results. For this lesson, cut sets will be
generated for the event tree, OBSTRUCT created in Lesson 2.

After the event tree structure and end states have been developed and saved, event tree sequences can be
generated by “linking” the event tree. Once the event tree(s) are linked and sequences generated, cut sets
can then be produced and quantified for each sequence.

This lesson will guide the user over four aspects to developing and analyzing event tree or sequence cut
sets:

Linking the event tree.
Solve for sequence cut sets.
Performing sequence uncertainty analysis.

Reporting sequence cut set results.

2.8.1 STEP 1: Linking Event Tree Sequences

The term “linking” event trees is the process of generating sequences logic using the event tree graphical
files and incorporating the top events of the event tree with the respected fault tree logic in the event tree
sequences.

To link an event tree and generate sequence logic, perform the following steps:

—

=

Select the Event Tree Button from the Graphical Tool Bar vt e

From the Event Tree List Window, highlight the OBSTRUCT event and right-click to invoke the
pop-up menu. Select the Link Trees option.
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LF I Show Sub-Trees Total # 1 Marked # 1

Add Event Tree

Edit Graphics
Edit Rules
Edit Partition Rules

Edit End Stakes

< |

Event Tree Mask

Mask Action
B |7 ) include £ Exclude Apply Mask I Exxit I

The Event Tree — Sequence Logic Generate screen is displayed. This screen allows the user to
view or send a sequence logic report to the screen, printer, or file. The default setting is set at “Do Not

Create a Report”. If the user wishes to see the generated sequence logic, select the “Send Report to
Screen” radio button.

Click the OK button to link the OBSTRUCT event tree and generate sequence logic.

—Report Options
" Do Mot Creste a Report
= Send Report To Screen
™ Send Report To Printer
= Send Report To File

File Mame I

—Sequence Probability Cut Off
* hlone

" Mormal (Use Split Fractions)

" Conditional (Split Fraction f |E Freguency)

Cut Off Walue I 1 .O00E-01 5

—Process Options

Create Logic Cut Sets? '

Mumber of Transfer Levels to Process I a9

mutually Exclusive Tap I

[8].4 | Cancel |
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2.8.2 STEP 2: Solve For Sequence Cut Sets

Once linking has been completed and sequence logic was created for the OBSTRUCT event tree,
sequence cut sets can now be generated. To generate sequence cut sets for the event tree OBSTRUCT,
perform the following steps:

Select the Sequence button Soquns from the Graphical Tool Bar. A listing of all the sequences
generated during the linking process will be displayed in Sequences screen.

Highlight all the sequences by either selecting the Apply Masks button at the bottom of the
Sequences screen or selecting the first sequence and dragging the mouse highlight cursor down the
sequence list until all three sequences are marked (or highlighted).

Hsequences - (PRACTICE) 7 =]
Taotal # 3 harked # 3
Evert Tree Sequence Analysis Type IRANDOM 'l
Quartify >
Uncerkainky
Cut Sets 13
Display >
Wiew Resules
Time Dependent
Event Tree Mame Mask Sequence Name Mask Sequence Logic Fault Tree
I [aro =] ] faro =] ] =
hask Action
’7(’3‘ mciude i Exclude Apply Masks | Exit

Right click to invoke the pop-up menu and select the Solve option.

The Cut Set Generation window as shown below will be displayed. If the “Cutoff Cut Set
Probability” box is check (default), then those cut sets with quantified value below the specified cutoff
value (located in “Cutoff Value” entry box) will not be retained. It the box is not checked, then all cut
sets will be retained. Click the OK button to accept the default cut set generation and truncation settings.
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Cut Set Generation Cutoff ¥alues d B3 I

Cutoff Cut Set Probahkility! [+ ¢ Conditional €% MNMormal = Cutoff Yalus [ oocE-os
Cutaff by Event Probability [~ Min = Cutoff Walue | 1.000E-005
Cutaff by € Size ¢ Zone % Mone = Cutoff Walue IB—
Solve Sequence YWFsult Trees i Flag Set Mame LI
Auto Apply Recovery Rules [+

MOTE: To perform Event Probakility truncstion you must also specify
Cut Set Probability truncation and the associated cutoff value.

L] Cancel

After the sequence cut sets have been generated, SAPHIRE returns to the Sequences screen. All
three sequences should still be highlighted. If not, click on the Apply Masks button to highlight all
sequences. To display the highlighted sequence cut sets, right click to invoke the pop-up menu. Select
the Display = Cut Sets option as shown below.

Hsequences - (PRACTICE) 2=
Total # 3 hiarked # El
Event Tree Sequence Analysis Type IRANDOM VI

Saolve

Guantify »
Uncertainky

Cuk Sets »

Wiew Results Comparison
Importance  #

Tii [n] dent
(S BEEFEIEE Uncertainky

Evert Tree Mame Mask Seguence Mame Mask Sequence Logic Fault Tree

[ IECEE N E IECEEINE =~

Mask Action
’7(: Include {T Exclude Lpply Masks | Exit
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The Selected Cut Set screen is displayed as shown below.

Selected Cut Sets - {(PRACTICE, OBSTRUCT, MULTIPLE}

iin Cut  1.800E-005  Mum 14 This List=== 1 .800E-005 100.00 % Mum 13
Cut Set %
M. Freguency Total Everts
1 1.200E-005 BEE6E  COMN-STP-FC-DEG1, COM-WHE-XA-RESEC, WST-DRM-FC-1
2 6.000E-006 3333  COMN-STP-FC-DEG1, COM-WHE-XA-RESEC, OP-HEP-BRK, WWST-DRM-FC-1
3 1.200E-003 om BRK-AIR-FC-COMP, COM-STP-FC-DEG1, COMN-WHE-KA-RESEC, WST-DRM-FC-1
4 3.600E-010 0.0 BRK-AIR-FC-RESY, COMN-STP-FC-DEG1, COMN-KHE-KA-RESEC, WWST-DRM-FC-1
a3 1.920E-010 000 BRK-CYL-FC-1, BRH-CYL-FC-2, CON-STP-FC-DEG1, COM-¥HE-XA-RESEC, WST-DRM-FC-1
5 4. 500E-011 0.0 BRK-CYL-FC-1, BRK-%LY-CC-2, COM-STP-FC-DEG1, CORM-XHE-KA-RESEC, WWST-DRM-FC-1
7 4.800E-011 000 BRK-CYL-FC-2, BRE-VLW-CC-1, COM-STP-FC-DEG1, CON-HMHE-XA-RESEC, WWST-DRM-FC-1
g 1.200E-011 0.0 BRE-YLY-CC-1, BRE-VLY-CC-2, COM-STP-FC-DEG1, COM-KHE-XA-RESEC, WST-DRM-FC-1
=] 9.600E-012 0.0 BRK-CYL-FC-1, BRK-DSK-FC-2, COMN-STP-FC-DEG1, COM-WHE-XA-RESEC, WST-DRM-FC-1
10 9.600E-012 0.0 BRK-CYL-FC-2, BRK-DSK-FC-1, COMN-STP-FC-DEG1, COM-HHE-XA-RESEC, WST-DRM-FC-1
1 2.400E-012 0.0 BRK-DSK-FC-1, BRK-YLY-CC-2, COM-STP-FC-DEG1, CORM-XHE-KA-RESEC, WWST-DRM-FC-1
12 2.400E-012 0.0 BRK-DSK-FC-2, BRK-YLY-CC-1, COM-STP-FC-DEG1, CORM-XHE-KA-RESEC, WWST-DRM-FC-1
13 4. 500E-013 0.0 BRK-DSK-FC-1, BRK-DSK-FC-2, COMN-STP-FC-DEG1, COM-WHE-XA-RESEC, WST-DRM-FC-1
4] | >
Slice By Importance
’7 Ewernt | Cutoff | ormal | Sets | Combio |
Cther List | MiEay | Eeport | Save | Exit

To view the basic events and their respected failure probability, highlight the desired cut set (for

example, highlight the first cut set) and click the View button
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7]
Ewvent Mame Walue

Cescription
I IE-CB 1.000E+000 IMITIATIMG EVEMT: OBSTRUCTION IM ROLDWYLY
COMN-STP-FC-DEG1 1.000E-002 LOAD SHIFTS AMND COMSTRAIMNTS LOCSERN
COM-HHE-¥A-RESEC 4 000E-002

OPFERATOR FAILS TO RESECURE LOAD

VWET-DRM-FC-1 3.000E-002 DRUM PACKAGE FAILURE

E Undefined End=tate

4]

Freguency 1.200E-005

BE.67 % Mumber of Events 4

ey Evert | Exit

2.8.3 STEP 3: Performing Sequence Uncertainty Analysis

The uncertainty analysis for sequence cut sets is very similar to that described for fault trees in Lesson 7

See Lesson 7 for a review of SAPHIRE’s uncertainty capabilities. For this example, sequence #6 will
have an uncertainty analysis performed.

To perform an uncertainty analysis on sequence #6, perform the following steps:

Select Sequence from the Graphical Tool Bar if the Sequence list screen is not shown.

Highlight the sequence OBSTRUCT 6. Right click to invoke the pop-up menu. Select
Uncertainty as shown below.
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Evert Tree Sequence Analysis Type IRANDOM 'l

o OBSTRUCT
CBRSTRUCT

Salve
Quankify
Uncertainky

Diisplay »
Wigw Results

Time Dependent

Evert Tree Mame hask Seguence MName Mask Sequence Logic Fault Tree

I Jore =1 ] fere =1 [ =
hiask Action
[C Include £ Exclude Apply Masksl Exit

The Uncertainty Calculation Values screen will be displayed. Enter the uncertainty
calculation valves given below.

Number of samples = 5000

Seed for random number generator = 54321
Uncertainty method = Monte Carlo

Mumber of samples (=99993) s000
Seed for random number generstor 54321|

Uncertainty method Ground Acceleration Level
" Latin Hypercube LI

f+" Morte Carlo

Intermediate Yalues
Cutput Walues [

File Mame I - - -
[oukput intermediate values o a file|

Ok Cancel |

Click the Ok button when all the values are entered.
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Uncertainty results will be displayed, as shown below, briefly on the computer screen following the
completion of the uncertainty calculation.

Uncertainty Results

Blame 51

Random Seed 54321 Events 13
Sample Size S000 cut Sets 12
Paint estimate 6.002E-006
Mean Valus 6.002E-D06
Sth Percentile »alue E.001E-006
Median Yalus 6.001E-D06
95th Percentile Walus 6.005E-D06
Mrinimum Sample Yalue E.001 E-Q0&
Maximum Sample Walues E.021E-O06
Stanclard Deviation 1.446E-003
Skewvness 3.953E+000
Hurtosis 4 435E+001
Elaps=ed Time 00:00: 00550

Click the Ok button to continue.

Uncertainty results can also be displayed by highlighting sequence #6 and right clicking to invoke the
pop-up menu. Select Display = Uncertainty to display the uncertainty results.

Sequences - (PRACTICE} 2|
Total # 3 harked # 1
Event Tree Sequence Analysis Type IR’ANDOM vl
o OBSTRUCT 2
CBRETRUCT 4
[s ICT
Solwe
Quankify »
Uncertainky

Cuk Sets 3
(o] ;

Cut Sets

Wiew Results Comparison
Importance  »

Time Dependenk

Ewvert Tree Mame Mask Sequence MName Mask Sequence Logic Fault Tree
I Jere =1 ] Jare =] =

Mask Action
’7(: Inelude " Exclude Apply Masks | Exit
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Click on Exit to leave the Sequence Uncertainty screen.

Click on Exit to leave the Sequence list screen.

2.8.4 Reporting Sequence Cut Set Results

To produce a report of the sequence cut set results, perform the following steps:

Select Reports ' rears | from the Graphical Tool Bar or the Menu Bar.

Select for the Data Type, the radio button located in front of the available option, Sequences.
For Report Type, select Cut Sets, as shown below.

Reporks Menu ﬂ E
—Data Type —Report Type —Zub Type

i Project  Summery

¢ Aftributes " Logic

" Basic Events

i Fautt Tree " Importsnce
" Event Tree " Custom
" End State

* Sequence

i~ Gate

i Hiztoorsm

= User Info Process Exit

Click on the Process button to continue.

The Sequence Cut Sets screen will be displayed as shown below. Highlight all the sequences by
left clicking the first sequence and dragging the mouse down the list of sequences until all are highlighted.
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Sequence Cutsets - {(PRACTICE) I S

s Analysis Type IR.&.NDOM |
* Current  Base

Event Tree Marme Description
" UCT

Cut Set Quantified Detailed Exit

Click on the Cut Set button to continue.

Click on OK to accept the default Cut Set Report Options.

Click on radio button located in front of Print (Default Printer) and click on the Ok button to
send the report to a printer.
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3. ADVANCED LESSONS

The purpose of the Advanced Lessons section is to familiarize the user with some of advanced features
and operation of SAPHIRE. The advanced features are not essential to perform a simple analysis in
SAPHIRE. However, for more complicated studies or PRA projects, the lessons covered in this section
will prove to be extremely powerful.

The lessons covered in the Advanced Section of this tutorial will expand on the techniques demonstrated
in Section 2, Basic Lessons. The lessons will use the Project, fault trees, and the event tree created in
Basic Lessons section.

The Advanced Lessons in this section includes the following:

Lesson 10. Creating Change Sets and Flag Sets

This lesson describes the difference between a flag sets and a change sets and guides the user on how to
implement into SAPHIRE.

Lesson 11. The “Linking” Rule Editor
Lesson 11 introduces the user to SAPHIRE “Link Event Tree” rule editor. The rule editor allows you
create rules that affect the event tree linkage process and sequence generation.

Lesson 12. Recovery Rules
Lesson 12 introduces the user the “Recovery Rule” editor of SAPHIRE. The recovery rule editor allows
you to create rules that affect existing cut sets in a “post-processing” manner.
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3.1 Lesson 10 — Creating Change Sets and Flag Sets

In lesson 10, the user will learn the difference between change sets and flag sets and why they are used in
SAPHIRE. An example change set will be created in the project PRACTICE and applied to specific basic
events and the data re-generated.

Change sets are user-defined set of changes that will be applied to the base case data when event data is
transferred to the current case data. Therefore, change sets adjust the base case data to a new user
specified value and then when the data is “generated”, it moves the new value into current case to be used
in an analysis. Change sets can be used to change probability values and basic event calculation types,
uncertainty parameters, and basic event attributes.

Flag sets are a special type of change set and can only contain either house flag changes to the calculation
type of process type changes. Flag sets are primarily used in SAPHIRE to manipulate logic gates by
turning house events embedded in the logic on or off, depending on the logic requirements. Flag sets can
only change the Calculation type to T (TRUE — i.e. guaranteed failure), F (FALSE — i.e. guaranteed
success) or I (IGNORE). In addition, specific types of process flags can be change with a flag set.

3.1.1 Creating a Change Set

Creating a change set is performed in SAPHIRE under the Generate menu option. There is no limit to
number of change sets that can be added to the database. Each change set must have a name and the
name given is limited to 24 characters. There are two types of change sets: class change sets and
individual change sets. Class change sets use a basic event attribute to search through the basic event list
in the database for a class of basic events to which the defined change applies. Individual change sets
only modify a user identified basic event. Once the basic event is selected, the user specifies the changes
to be applied to the basic event. Within a change set, both class changes and individual changes can be
applied. However, individual changes will overwrite the class change.

The following example will create a simple change set called “CHANGE1” that changes the basic event
probability of BRK-AIR-FC-COMP from 1.0E-4 to 1.0E-1. The change set will then be applied to
database and fault tree BRAKE-SYS will be re-quantified with the new value.
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STEP 1: Creating and Naming a Change Set
To create a change set in SAPHIRE, perform the following steps:

Select the Generate button from the Graphical Tool Bar. '\@c

Generate

The Generate screen will be displayed as shown below. The screen list any change sets in the
database (currently, there are no change sets in the project). Place the mouse cursor anywhere in the
Generate screen and click the right mouse button to invoke the pop-up menu. Select Add.

Generate - [PRACTICE] [ 2]
Change Set Mame Change Set Description

kadifu
Delete

Copy
Text Edit
Mark. /U nrnark.

Default Mizsion Time I 2.400E+001 Right Click for Menu Options
Class I Single | Report Generate I Exit I

The Add Change Set screen appears as below. Type in the Name Box, CHANGEI and type in
the Description Box, Change Set Example One. Click on Ok when completed.

Add Change Set - [PRACTICE] 7 x|
Mame CHARNGE]
Descrigtion CHAMNGE SET EXAMPLE ONE|
Drste 200310872

Ok I Cancel |

STEP 2: Modifying the Data in the Change Set
To modify the basic event failure and/or uncertainty data in the change set, perform the following steps:

The new change set, CHANGEI has been added to the Generate screen. Select the change set
CHANGEI! by clicking on with the left mouse button.
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CHANGE]1 will be an “individual” change set. Click on the Single Button. The Change Set
Event screen will be displayed as below. No basic event exist in the change set therefore, the screen is

blank. To add basic event to be changed, click the right mouse button to invoke the pop-up menu and
select Add.

Change Set Events - [PRACTICE. CHANGE1) 2]

SLF P C Mame Description

SLF Evert Lsage Flags: S—=S-equence cut sets, L=Fault Tree =L=ogic, F=Fault Tres cut sets
-=unused, b= hase case, © = currert, B = Both
PEC Change Set Flags: P = prob., C = class

Right click for menu options Exit

The Select Change Set Event screen is displayed. This lists includes all the basic events in the
project. Select the basic event, BRK-AIR-FC-COMP and right click to invoke the pop-up menu. Select
Add from the pop-up menu.

The Event Probability screen is displayed as shown below. The left side of the screen, under the
heading Random Failure Data indicates the base case data for the selected event, BRK-AIR-FC-
COMP. The right side of the screen contains the entry boxes for current case data that will be
implemented after the data is generated.

For the Mean Failure Probability, type in the new value of 1.0E-2 in the data entry box as shown below.
Click the OK button when completed.
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Ewent Probability Changes -

st Attributes Susceptibilties
=P=BRK-AIR-FC-COMP Compld  FMode  Location 1 2 3 4 5 6 7 &
<8 -BRH-SIR-FC-COMP (200 el Sl ey Sy il iy
=T= Type System Train 9 10 11 12 13 14 15 16
Category: (I i e e e i
Random Failure Data
Baze Current

1 Calculstion Type I - =BLAMNK= Mo Change ;I

1 .000E-004 hlean Failure Probability 1E-2

+0.000E+000 Lamkdla

+0.000E-+000 Tau

+0.000E+000 Mis=ion Time

Uncertainty Data
L LogMormal Distribution [ ani- Mo Changs =
vpe
S.000E+QOO | ST
— Eeeeo T E-—-

Correlation Class I
Process Flag I Ij

Cancel |

Leawe Current “alues blank
if no changes are desired.

The Change Set Events screen now has one basic event, BRK-AIR-FC-COMP, as shown below.

Change Set Events - (PRACTICE, CHANGEL) 7=
SLF PC Hame Description
e P BRK-AIR-FC-COMP FAILURE OF &IR COMPRESSOR

| |

SLF Evert Usage Flags: S=<S=ecuence cut sets, L=Fauk Tree <L=ogic, F=Fault Tree cut sets
- = unused, b = base case, © = current, B = Both

PAC Change Set Flags: P = prob, G = class

|+

Right click for menu options Exit

Click on the Exit button Ll )

STEP 3: Marking the Change Set to be Used by SAPHIRE

Once the basic event BRK-AIR-FC-COMP has been added to the change set and rate information
adjusted accordingly, the Generate screen will now have one change (the CHANGE! change set) listed as
shown below. However, the change set will NOT be implemented by SAPHIRE unless it is marked (i.e.
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initialized). Marking a change set tells SAPHIRE to implement the data changes in the change set and
copy the changed data into the current case data to be used for analysis.

To MARK a change set, perform the following steps:

Highlight the CHANGEI change set and click the right mouse button to invoke the pop-up menu.
Move cursor to Mark/Unmark to mark the change set. A change set can also be marked by double-
clicking the left mouse button on the change set name in the Generate screen.

Generate - {(PRACTICE)
Change Set Mame Change Set Description
CCHAMGE? g Qe SR e~ WPLE CINE

Modify
Delete
Copy
Text Edit
MarkfUnmark

Default Mizsion Time I 2.400E+001 Right Click for Menu Options
Class | Single | Eeport Senerate | Exit I

Once the change set, CHANGE] is successfully marked, a number 1 is located in from of the
change set name. This marking informs the user that the change set has been marked and will be the first
change set implemented.

To invoke the change set and therefore moving the data changes into the current case, click on the

Generate
Generate —_l button.

After the Generate button is activated, the data is moved into the current case. The data is now
ready to re-analyze with the new data.
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STEP 3: Analyzing with the Marked Change Set
To re-analyze the fault tree, BRAKE-SYS with the change set, CHANGE1 marked, perform the
following steps. See Lesson 6 for a more detailed review of analyzing fault trees.

UICK TIP

SAPHIRE is capable of implementing multiple change sets during the Generate process. However,
the order of “marking” the change sets is important. The first change set selected, which will be
marked by a number “1” will be applied first during Generate. If a second change set is marked, it
will be marked with a number “2”. This change set will be applied second and override any changes
in the first change set if they happened to change the same basic event.

Select the Fault Tree button from the Graphical Tool Bar.

Highlight the fault tree, BRAKE-SY'S and click the right mouse button to invoke the pop-up menu.
Select Solve.

The Cut Set Generation screen is displayed. Accept the default truncation levels by clicking on
the Ok button.

The Cut Set Generation Results screen is displayed. The new results show an increase to 5.05E-
1 for calculated fault tree failure probability. Click on the Ok button to exit the Cut Set Generation
Results screen.

STEP 4: Unmarking the Change Set

The changes to the base case data in the current case will remain in effect until the Change Set is
unmarked and the data regenerated. This takes the original data of base case and moves it back into the
current case.

To unmark (or deactivate) a change set, perform the following steps:
B
&,

Select the Generate  @enerat=: Button from the Graphical Tool Bar.

Highlight the Change Set, CHANGEI! and right click to invoke the pop-up menu and click on
Mark/Unmark. This action de-selects the change set. [4 second method to unmark a change set simple to
double click on the marked change set.]
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Generate - {(PRACTICE) I E3

Change Set Mame Change Set Description

CHAMGE SET EXAMPLE 1

Add
Modify
Delete

Copy
Text Edit
MarkfUnmark

Default Mission Time I 2 400E+001 Right Click for Menu Cptions
Class | Single | Report Generate | Ezxit I

Click on the Generate button ﬂl located at the bottom of the screen to move the original
base case data back to the current case.

3.1.2 Creating a Flag Set

Even though a flag set is a special type of change set, flag sets are not created in the Generate Menu.
Flag sets are created in Modify menu option and are applied to the database by directly “attaching” them
to fault trees or event tree sequences.

The following example will create a simple flag set called “FLAG1” that changes the basic event
calculation type of the basic event OP-HEP-BRK to FALSE. The flag set will then be assigned to fault
tree BRAKE-SYS and then re-quantified with the flag set.

STEP 1: Creating and Naming a Flag Set
To create a flag set in SAPHIRE, perform the following steps:

ﬂ' button

In the Flag Set screen as shown below, click the right mouse button to invoke the pop-up menu.
Select Add.

Select the Modify Ld'fvl button from the Graphical Tool Bar, then select the Flags
(or from the Menu Bar Select Modify > Flags).
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e

Zapy
Modify
Delete

Right Click for Menu Options .

Test Flags Exit

In the Add Flag Set screen, enter in the Name box FLAG1. A description is not required.

2]
[Mame FLAG
Description | Flag set example|
Diate 20030826

Ok I Cancel |

Click the Ok button to add the flag set.

STEP 2: Modifying the Calculation Type in the Flag Set
To modify the basic event Calculation Type in the flag set, perform the following steps:

In the Flag Set screen, as shown below, highlight the flag set, FLAG1 and click the Flags ﬂl
button located at the bottom of the Flag Set screen.

The Flag Set Events screen is displayed. To add events to the flag set that will be modified, right-
click to invoke the pop-up menu and select Add.

The “Select Flag Event” screen is displayed as shown below. Select the basic event, OP-HEP-
BRK by double clicking on the basic event or right clicking and selecting Add from the pop-up menu.
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Select Flag Event - {Right click for options) 7|

=FALZE= System Generated Success Event
=IMIT= System Genersted Intisting Evernt
=PA&ASE= System Generated lgnore Event
=TRIIE= System Generated Failure Event
BRAKE-SYS TRUCHK AR BRAKES FAIL
BRH-AIR-FC-COMMP FAILURE OF AR COMPRESSOR
BRK-AIR-FC-RE=' FAILURE OF AIR RESERYOIR
BRH-CYL-FiZ-1 BRAMKE CYLIMDER 1 FAILURE
BRH-CYL-FZ-2 BRAKE CYLIMNDER 2 FAILURE
BRH-DSH-FiZ-1 BRAKE DISH 1 FAILURE

BRH-DSH-FZ-2 BRAKE DISH 2 FAILURE

BRH-WLY-CC-1 BRAKE “ALWE 1 FAILURE

BRH- LY -CC-2 BRAKE wALWE 2 FAILURE
COMN-STRP-FC-BRH

COMN-STP-FC-DEG LOAD SHIFTS ARD COMSTRAIMTS LOOSER
COR-HHE-HA-RESEC OPERATOR FAILS TO RESECURE LOAD
IE-2B IMITIATIMG EWERT: QBSTRUCTIOMN [N RO ADV AN
LOAD LoAD COMNTRAINTS FAIL

LOoaD

LOAD2

OP-HEP-BRK

OP-HEP-MCHE DOPERATOR MAREUVERS TRUCH
OP-hANELNER DOPERATOR ANOIDE OBESTRUCTION
ChTIER

(WWST-DRM-FC-1 DRUM PACKAGE FAILLRE

WWET-DRM-FC-2

4| | 3

The “Event Probability Flags” screen is displayed as below. The flag set data screen allows you
to enter changes on the right side of the screen. Note that only the Calculation Type or a Process Flag can
be modified in Flag Set. Under the Current case drop down menu, select “F- House Event (Success)”
and click on the Ok button.

Event Probability Flags 2 x|
Mames Attribwtes Susceptibilties

=P=0P-HEP-BRK Comp Id System  Train 123 4 5 6 7 8

=&=0P-HEP-BRK ¥ MMM N MMM

Category  Type  FMode  Location 910 11 12 13 14 15 16
MM MM MNMNRKN

Random Failure Data
—Baze Current

1 Calculation Type

Procesz Flag

Mate : Leawe Current Walues blank if no changes are desired.

Ok Cancel |

Click on the Exit button to leave the “Flag Set Events” screen.
Click on the Exit button to leave the “Flag Sets” screen. The Flag Set, FLAGI1 is now ready to use

in the database. Click on the Return _rewm | button to return to main SAPHIRE menu screen.
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STEP 3: Using the Flag Set

To use a flag set after it has been created, you must assign it to a sequence or a fault tree. The following
example assigns the Flag Set, FLAGI to the fault tree BRAKE-SYS. To assign a flag set to a fault tree,
perform the following steps:

Click on the Modify Lﬂ“ﬁfl button and then click on the Fault Tree \M‘ button (or select

Modify - Fault Trees from the menu bar.
Highlight the BRAKE-SYS fault tree and right click to invoke the pop-up menu. Select Modify.

The Modify Fault Tree Screen appears as below. To apply the Flag Set, type in the Flag Set
name (“FLAG1”) in the box field labeled Flags Name.

Modify Fault Tree |2 =]
Marme BRAKE-SYS Prok Cutoff | ------ E----
Cre=scription TRUCK AR BRAKES FAIL
Systemn Code I~ Sub-Tree Flags MName I FLAG|

—Ewantification Method
' MnCut ¢ RareEvert & MinMax Mumker of Passes I 3

—Current Case Min Cut Upper Bounds
Analysis Type:

1 | s5.050E-001 - [ E-mmx =10 [— E---- LF- T [— E--m
R [ E--m (=3 [— E-mmx R [a g [— E---- (T — E--m
fc I [— E--m A [ E-mmx L R [— E---- 15 |-l E--m
I - E--m F= I E-mmx 12 | s E---- LT3 — E--m
Ok I Cancel

Click the Ok button when complete. The Flag Set is now assigned to the fault tree BRAKE-SYS and will
be applied when the fault tree permanently until it is removed from the “Flags Name” box.

To solve the fault tree, BRAKE-SYS with the flag set applied, select Fault Tree <highlight the BRAKE-

SYS fault tree and right click> = Solve <click Ok to accept the default truncation values> The new
results with the operator action set to FALSE is shown below at 1.57E.
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Cut Set Generation Results

Marme: BRAKE-SvE
Elapsed Time:  00:00:00.020

Cut Sets UpperBound

Size #
1 1 S00E-004

2.704E-003

w oD - m th B W R

-
]

o o o o o o o o o o M

W
-
]
-
-

Total 1 570E-004

STEP 4: Removing the Flag Set
To remove the flag set from the fault tree, BRAKE SYSTEM:

Click on the Modify Lﬂ'ﬁ’| button and then click on the Fault Tree \m‘ button (or select

Modify - Fault Trees from the menu bar.
Highlight the BRAKE-SYS fault tree and right click to invoke the pop-up menu. Select Modify.

The Modify Fault Tree Screen appears as below. To remove the Flag Set, delete the flag set
name (FLAGI) in the box field labeled Flags Name.

3.2 Lesson 11 - The “Linking” Rule Editor

In lesson 11, the user will be introduced to the linking rule editor. This editor allows rules to be written
that are used when sequence logic is generated. Without using linking rules, the sequence logic consists
of the logical combinations of failed and successful top events. With these linking rules, the user is
allowed to replace the top event with a substituted top event based on the logical conditions dictated by
the rule. These rules also allow the user to assign flag sets (see the previous section) to sequences also
based on the logical conditions dictated by the rule.

The linking rule editor uses standard programming (i.e. FORTRAN, BASIC) line format and structure.
Standard common symbols include:

| Denotes a comment line
~ Logical operator for “not present”
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* Logical AND operator (i.e. A AND B occur)

+ Logical OR operator (i.e. A OR B occurs)
/ Complement
O Parentheses for grouping terms

Once linking rules have been written, the rule searches the event tree logic for the specific search criteria
specified by the user in the rule. Once the search criteria are met, the rule replaces the default top event

(i.e. original top event) by a new top event that is previously specified. Typical search criteria examples
used by the linking rule editor are:

Table 2. SAPHIRE Linking Rule Search Criteria Examples

Search Criteria Example Meaning of Search Criteria

A If A then If “A” occurs then do this...

/A If /A then If “A” does not occur then do this...

~A If ~A then If “A” is not present then do this...

A*B If A * B then If“A” and “B” occurs then do this...

A+B If A + B then If “A” or “B” occurs then do this...

(A+B)*C If (A+B)*Cthen |I“A” or “B” occurs and C occurs then do this...
always If always then The search criteria are always met so do this...
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The linking rule editor is implemented when the “Link Event Trees” operation is being performed and the
sequence logic is being created. If the linking rules have been written, the rule searches the event tree
logic for the search criteria specified in the rule and replaces the original top event in the event tree with a
new top event. For example, the following linking rule would replace top event C with a new top event
C-SYS if the search criteria A * B is met (i.e. if A and B are both failed):

if A * B then

/C = C-SYS;
C = C-SYS;
Endif

The /C = C-SYS line replaces the success branch of the event tree while the C = C-SYS line replaces the
failure branch. In the rule editor, for /C = C-SYS, the complement forward slash for /C-SYS is implied
and not required (a complemented top event is automatically replaced by a new complemented top event).
In addition, it is required by the rule editor that any replacement line must end with a semicolon (3).

There is no limit to the number of replacement lines that can be used in a rule.

More detailed information on rule structure, keywords, and nomenclature can be found in the Technical
Reference Manual (Volume 2).

This lesson will guide the user on adding a substitution fault tree (i.e. top event) to the event tree
OBSTRUCT created in Lesson 2. The substitution will require the user to enter a linking rule into
SAPHIRE and then re-link the event tree with the compiled linking rule.

3.21 STEP 1: Creating the New Substitution Fault Tree

For a new fault tree to substitute for the existing fault tree, the logic for new fault tree must first be
created. Refer to Lesson 2 for instructions on creating a fault tree in SAPHIRE. Figure 20 illustrates the
new fault tree to be substituted in the event tree OBSTRUCT. Create the following fault tree in
SAPHIRE by performing the following steps:
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LOAD
CONSTRAINTS
FAIL

DRUM PACKAGE
FAILURE

3.0E-2
WST-DRM-FC-1

LOAD1
I 1
LOAD
STRAP
FAILS
LOAD1-STP
I 1
LOAD LOAD
CONTRAINTS CONSTRAINTS
WEAKEN FAIL
1.0E-1
LOAD1-A CON-STP-FC-BRK

LOAD SHIFTS
AND CONSTRAINTS
LOOSEN

1.0E-2

CON-STP-FC-DEG1

OPERATOR FAILS
TO RESECURE
LOAD

4.0E-2

CON-XHE-XA-RESEC

LOAD1 -

LOAD CONSTRAINTS FAIL

2002/12/16 Page 3

Access the Fault Tree Graphical editor by clicking on the Fault Tree button and then right

Figure 20 LOAD1 Substitution Fault Tree

clicking to invoke the pop-up menu. Select Add Fault Tree.

In the Fault Tree screen, type in the name of new fault, LOADI as shown below. Click the Ok

button when complete.

Highlight the new fault tree, LOAD]1 and right click to invoke the pop-up menu. Select Edit
Graphics. Create the fault tree shown in Figure 20 using the graphical editor. Click the Save button and

Fault Tree 7| x| I
Mame [Rerey|
Cescription L&D COMTRAIMTS FAIL

Swatem Code

Flags Mame

Quantification ¢« in oyt ¢ Rare Evert (0 MiniMax

hiethod

l— [ Sub-Tree

Ok Cancel

Prob Cutoff I ______ E---—-
Mumber of Passes I ——-

exit the graphical editor.

Click the Exit button to leave the Fault Tree List Screen.

With the creation of the new fault tree, LOAD1, there was one basic event added to the database
(CON-STP-FC-BRK). The failure probability for this basic event is 1.0E-1 with an error factor of 10.
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Go to Modify > Basic Events and add this data to the basic event CON-STP-FC-BRK. See Lesson 4
for detailed information on modifying basic event data.

3.2.2 STEP 2: Creating the Linking Rule

The new fault tree, LOADI has logic that is designed to give a slightly higher probability, due to a
specific event tree scenario. It was designed for Sequence 4 of the event tree, OBSTRUCT where the
truck brake system has failed but the driver has succeeded to avoid the obstruction in the road. Therefore,
to be applied to sequence 4, a linking rule needs to be written that substitutes the LOAD top event with
LOADI when BRAKE-SYS has failed but OP-MANEUVE is successful.

| s |

Linking rules are entered into SAPHIRE through the Event Tree menu button v | To write a rule

that accomplishes the desired substitution, perform the following steps:

Select the Event Tree button in the Graphical Tool Bar.

Highlight the OBSTRUCT event tree and right click to invoke the pop-up menu. Highlight Edit
Rules.

The Linkage Rule Editor is displayed as below.

File Edit Search Window List Help
x| 0l=E] = %[mE @] ms|me=
k<eof= =l

L: 1 C:0 [Insert [

The substitution requires a rule that replaces LOAD with LOAD1 when BRAKE-SYS and OP-
MANEUVE both fail (i.e. down braches on the event tree). To accomplish this, type in the following rule
in the rule editor shown below.
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File Edit Search ‘Window List Help

x|o=d < &= Qo =™ =|m|E|

=
| Fule substitutes top ewvent LOAD for LOADIL ;I
| if BRAKE-23¥3 and OP-MAWNEUVE fail.

if BRAEKE-SY¥3 * JOP-MANEUVER then
SLOAD = LOAD1:
LOAD = LOADIL;

endif

<<eof=>

21|
BRAKE-SYS
LoD
[MePiing]
LoAaD2
OP-MANELVER

LI |

L: 9 C: 0 Insert | |

Note: The Fault Tree List box shown above is obtained by clicking on List in the Linkage Rule Editor
and then Systems (Fault Trees).

To exit the linkage rule editor, click on the EXit button x| and click on Yes to save the linkage
rule. This now a “+” symbol next to event tree name, OBSTRUCT. This indicates to the user that there
are linkage rules associated with the event that have successfully been compiled (a “-* sign would
indicate that there are rules associated with the event tree but, they were not successfully compiled).

3.2.3 STEP 3: Re-Linking the Event Tree Sequence
In order for the substitution rule to take place, the event tree must be re-linked and new event tree logic
sequences generated. To link the event and generate new sequence logic, perform the following steps (for
more detail on linking, see Lesson §):

Select the Event Tree Button from the Graphical Tool Bar.

From the Event Tree List Window, highlight the OBSTRUCT event and right-click to invoke the
pop-up menu. Select Link Trees option.

The Event Tree — Sequence Logic Generate Screen is displayed. To view the new logic and

confirm that the substitution took place, click the radio button in Report Options in front of Send Report
to Screen. The following report will be displayed.

73



Ejreport ¥iewer - SAPHTEMP.0OD =]

Eile: Edit Opkions  Help
Seguence Mame H Fault T»ee H Fault Tree H ;l
Event Tree Mame: OBSTRUCT [
6 ! BRAKE—-SY¥S H OP—MAMNEUUVER H
! LOAD H
end state: RELEASE
4 ! BRAKE-SY¥S : ~OPFP—-MANEUUVER
! LOoAD :
substitutes ! LOoAD1
end state: RELEASE
! ~»BRAKE—SY¥S H LOAD
end state: RELEASE
Saved Seguences: 3 Ualid Seguences: 3 Processed: 3

From this report, it can be confirmed that for sequence #4, LOADI1 has been substituted for LOAD. Click
the exit button located in the upper right corner to exit this report.

3.2.4 STEP 3: Re-solve For Sequence Cut Sets

The new sequence can now be solved with the fault tree top event logic being used. To solve for cut sets,
perform the following steps:

Select the Sequence button from the Graphical Tool Bar.

Highlight all the sequences. Right click to invoke the pop-up menu and select the Solve option.
Click Ok to accept the default truncation values.

Right click to invoke the pop-up menu and select Display = Cut Sets. The new cut sets will be
displayed as shown below.
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Selected Cut Sets - {(PRACTICE, OBSTRUCT, MULTIFLE} 2] x|

hdim Cuit 1.800E-005  Mum 14 Thig List=== 1.800E-00= 100.00 <% Mum 14
Cut Zet %
Mo, Frequency Tatal Ewvents
1 1.200E-005 EE.EE COM-STP-FC-DEG1, COM-XHE-XA-RESEC, WET-DRM-FC-1
2 6 .000E-006 3333 COM-STP-FC-DEG1, COMN-HKHE-HXA-RESEC, OP-HEP-BRK, WST-DRM-FC-1
3 1.200E-009 oo BRK-AIR-FC-COMP, COM-STP-FC-DEG1, COM-KHE-XA-RESEC, WIT-DRM-FC-1
4 S.EO0E-010 0.a0 BRK-AIR-FC-RESY, COMN-STP-FC-DEG1, COMN-XHE-XA-RESEC, WST-DRMM-FC-1
3 1.920E-010 0.a0 BRH-CYL-FC-1, BRK-CYL-FC-2, COM-STP-FC-DEGT, CON-RHE-XA-RESEC, WST-DRM-FC-1
=] 4 .800E-011 0.00 BRE-CYL-FC-1, BRE-WLY-CC-2, COM-STP-FC-DEG1, COMN-HHE-HA-RESEC, WST-DRM-FC-1
7 4 S00E-011 0.a0 BRK-CYL-FC-2, BRK-VLW-CC-1, COM-STP-FC-DEG1, COM-XHE-XA-RESEC, WET-DRM-FC-1
g 1.200E-011 0.a0 BRE-VLW-CC-1, BRH-VLW-CC-2, COMN-STP-FC-DEG1, COMN-XHE-XA-RESEC, WET-DRM-FC-1
9 9. B00E-012 0.00 BRH-CYL-FC-1, BRK-DSKH-FC-2, COM-STP-FC-DEG1, COM-HHE-HA-RESEC, WST-DRM-FC-1
10 9.B00E-012 0.a0 BRK-CYL-FC-2, BRK-DSK-FC-1, COM-STP-FC-DEG1, COMN-HHE-XA-RESEC, WET-DRM-FC-1
11 2.400E-012 0.a0 BRE-DEK-FC-1, BRK-VLW-CC-2, COM-STP-FC-DEG1, COMN-XHE-XA-RESEC, WET-DRM-FC-1
12 2. 400E-012 0.00 BRK-DSK-FC-2, BRK-YLY-CC-1, COM-STP-FC-DEG1, COMN-HWHE-HA-RESEC, WST-DRM-FC-1
13 4 800E-013 0.00 BRK-DSK-FC-1, BRE-DSKH-FC-2, COM-STP-FC-DEG1, COM-HMHE-HA-RESEC, WST-DRM-FC-1
14 0.000E+000 0.a0 =FALSE=
1| | =
Slice By Importance
’7 Ewert | Cutoff I ’7 Mormal I Sets | Combno |
Cther List | Wiew I Eeport | Save | Exit

3.3 Lesson 12 — Recovery Rules

In Lesson 12, the user will be introduced to the “Recovery Rule” editor. This editor allows rules to be
written that affect existing cut sets in a “post-processing” fashion. The SAPHIRE Recovery Rules are
logic rules that allow for the alteration or deletion of fault tree or sequence cut sets. The recovery rules
can be used to add recovery events to both sequence or fault tree cut sets, add common-cause failure
events to cut sets, or eliminate events or combination of events that cannot occur (i.e. mutually-exclusive
events).
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The Recovery Rule editor uses standard programming (i.e. FORTRAN, BASIC) line format and structure.
Symbols, nomenclature and structure for the Recovery Rule editor are very similar to the Linking Rule
editor. The main difference between the two is that Linking Rules search the top events as search criteria
while Recovery Rules search existing cut sets as a search criteria. Standard common symbols include:

Denotes a comment line
Logical operator for “not present”

|

* Logical AND operator (i.e. A AND B occur)
+ Logical OR operator (i.e. A OR B occurs)

/ Complement

O Parentheses for grouping terms

Once the recovery rules have been written, the rule searches the either the sequence or fault tree cut sets
for the specific search criteria specified by the user in the rule. Once the search criteria is met, the rule
manipulates the cuts as directed by the user (i.e. add basic events to the cut set, delete basic events from
the cut set or delete the cut altogether). Typical search criteria examples used by the linking rule editor
are:

Table 3. SAPHIRE Recovery Rule Search Criteria Examples

Search Criteria | Example Meaning of Search Criteria

A If A then If “A” occurs in the cut set then do this...

/A If /A then If “A” does not occur in the cut set then do this...

~A If ~A then If “A” is not present in the cut set then do this...

A*B If A * B then If“A” and “B” occurs in the cut set then do this...

A+B If A + B then If “A” or “B” occurs in the cut set then do this...

(A+B)*C If (A+B)*Cthen | If“A” or “B” occurs and C occurs in the cut set then do
this...

always If always then The search criteria are always met in every cut set so do
this...

The recovery rule editor is implemented after the cut sets are generated using the Solve command (i.e.
searches on pre-existing cut sets). If the recovery rules have been written, the rule searches all the cut sets
for the search criteria specified in the rule and manipulates the cut set as directed. For example, the
following recovery rule would add a recovery event, B-REC, to any cut set that it found that contained
both basic events A and B:
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if A * B then
recovery = B-REC;
endif

It is required by the rule editor that any action line (after a “then” statement) must end with a
semicolon (;). There is no limit to the number of search criteria lines that can be used in a rule.
More detailed information on rule structure, keywords, and nomenclature can be found in Technical
Reference Guide.

This lesson will guide the user on adding a recovery event to fault tree LOAD1. The recovery rule allows
credit in the cut set results for the driver to isolate the spilled contents of drum if the Load constraints fail.

3.3.1 STEP 1: Creating a Recovery Rule

The recovery rule example will be applied to fault tree, LOAD1. Therefore, this recovery rule is “fault
tree recovery rule” and will only be applied to the fault tree cut sets. If the user wanted it to be applied to
the sequence cut sets, it would be written as a “sequence recovery rule” (found under the Sequence
menu option). Fault tree recovery rules are entered into SAPHIRE through the Fault Tree menu button

Faulk Tree

The recovery rule purpose is to add a recovery basic event, OEP-SPILL-ISO, to any cut set in fault tree,
LOADI that contains the basic event that represents the drum rupture (i.e. WST-DRM-FC-1) and the load
constraints (or straps) failed (i.e. CON-STP-FC-BRK). To write a rule that accomplishes this function in
the LOADI fault tree, perform the following steps:

b3
Select the Fault Tree button ratre| from the Graphical Tool Bar.

Highlight the fault tree, LOADI1 and right click to invoke the pop-up menu. Select Cut Sets 2>
Recover - Edit Rules as shown below.
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Fault TreesList - (PRACTICH) e B
Total # 5 Marked # 1 [~ Show Sub-Trees Analysis Type IRANDOM vl

C  ER&KE-SYS TRUCK AIR BRAKES FAIL
LOAD LOAD CONTRAINTS FAIL
LOZD1 L TRAINTS FAIL
LOAD2 LOAD CONSTRAINTS FAIL
CP-MANELVER CPERATOR AYOIDS SBSTRUCTIO

add Fault Tree

Edit Graphics
Edit P+IC
Edit Logic
Page Tree

Solve
Quantify 3
Unicertainty
Cut Sets
Display 3
Wiew Resulks ] er Edit Rules
Time Dependent Batch anly
T Interactive

Project Rules

Fault Tree Mask Mask Action
I* ’7 % nciude € Exclude Apply Mask Exit

The Recovery Rule is displayed as shown below.

&

File Edit Search Window List Help

x| 0S" = &|@=el Qe ™2

<<eofs> =]

il H 4
bt e fmser [ [ [ Y

The recovery rules require that the basic event OEP-SPILL-ISO be added to the database. This can
be directly in the rule editor by selecting List from the rule editor’s menu bar and then selecting Events.
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The Event List Box will be displayed. Place the mouse cursor inside the box and right-click to
invoke the pop-up menu. Select Add. The Add Event screen is displayed. Enter as the Primary Name,
OEP-SPILL-ISO and a Mean Failure Probability of 1.0E-1 with a Lognormal distribution and an
Error Factor of 3, as shown below.

Add Event I E3

Ewent | Attributes I Process Flag I Template I Transformations I Uncertainty I

Event Mames

Pritmary I QEP-SPILL-IZO Alternate I CEP-SPILL-IZO

Dezcription I OPERATOR FAILS TO ISOLATE SPILL

Random Failure Data Uncertainty Dats
Type |1 - Probability x| | Tvre ||_ - Log Marrmal =
Mean Failure Prokbakility 1 .000E-001
Lambda I Error Factar = N00E+000
L= % T e S e E-—-
hission Time Correlation Class I
Ok I Cancel

Click on the Ok button when completed.

Type in the recovery rule shown below. Double clicking on a basic event in the Event List box
places that event inside the rule editor in the last location of the cursor.
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Fil= Edit Search wWindow List Help

x|l «| &6 o’ ™ 8|0E)

| This Recowery Fule adds the hasic event, OEP-3PILL-ISO to ‘:J

| any cut set that has the basic event WET-DRM-FC-1 and CON-STP-FC-EBRE
| inzluded in it.

|
if W3T-DREM-FC-1 * CON-STP-FC-BRE then
recovery = OEP-ZIPILL-ISO:;

<<eofx>=

OP-HEP-BRK
OP-HEP-MOWE
OP-hAMNELVER

ChMER:
WS T-DRM-FC-1
(WS T-DRM-FC-2

1| | 3

S

=il »

To exit the recovery rule editor, click on the Exit button || and click on Yes to save the recovery
rule.

3.3.2 STEP 2: Re-solve For Fault Tree Cut Sets

The fault tree, LOAD1 can now be solved with the fault tree recovery rule being implemented. To solve
for cut sets, perform the following steps:

If the LOADI fault tree isn’t highlighted, click on the LOAD1 fault tree and right-click to invoke
the pop-up menu. Select the Solve option.

The Cut Set Generation screen is shown as below. Make certain that “Auto Apply Recovery

Rules” box is check. This automatically applies the recovery rules during the Solve command. Click
Ok to continue.
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Cut Set Generaktion E E

Cutoff by Cut Set Probakilty! W € Fault Tree (% Global = Glokal Cutoff Yalue | 1 D00E-D15

Cutoff by Event Probability [ Min = Cutoff Yalue | E----
Cutaff by ¢ Size  Zone % pone = Cutoff Yalue | =
Starting Gate Mame I Flag Set Mame j

Auto Apply Recovery Rules v
MOTE: To perform Event Probakility truncation you must also specify
Cut=et Prokahbility truncation and the associsted cutoff value.

]2 Cancel |

Note: If the user wanted to apply recovery rules manually, then un-click the “Auto Apply Recovery
Rules” box. Apply the recovery rule by right-clicking on the LOADI fault tree and selecting Cut Sets

- Recover > Apply Batch. This command will apply the recovery rule after the cut sets have been
solved.

Click the Ok button in the Cut Set Generation Results screen.

To display the cut set with the recovery event applied, select the LOAD1 fault tree and right- click
to invoke the pop up menu. Select Display > Cut Sets. The Selected Cut Sets screen is shown as
below. Notice now that the recovery event OEP-SPILL-ISO is present in the cut set with the basic event,
WST-DRM-FC-1 and CON-STP-FC-BRK.

selected Cut Sets - (PRACTICE, LOAD1) 7
tlin Cut S3120E-004  Mum 2 This List===  3.120E-004 10000 %% Mum 2
Cut Set U
Mo Freguency Total Everts
1 3.000E-004 9515 COM-STP-FC-BRK, OEP-ZPILL-IZO, WYW=T-DRM-FC-1
2 1.200E-005 385 COMN-STP-FC-DEG1, COMN-XHE-XA-RESEC, WST-DRM-FC-1
4| | 1|
Slice By Importance
’7 Ewert I Cutoff | ‘ ’7 Mormal I Sets I Combo I
Cther List | pa (= I Report I Save I Exit I
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3.4 Completion of the Tutorial

At this point in the process, both the basic functionality and some advanced features have been addressed.
Stepping through the 12 different lessons demonstrated the event and fault tree development process and
explained how to generate minimal cut sets using these models. For additional information, the reader is
guided to the other volumes that accompany this report.
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